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 INNO PLAN is stand-alone software designed for trained qualified dental practitioners. 

 The key scientific concept of the INNO PLAN software is the visualization of a patient’s medical image data 

(DICOM file from third-party CT/CBCT scanners) to pre-operative digital implant planning, surgical guide (drill 

guide) file (output of the pre-operative implant planning) creation. 

 

 

 The followings are the major functions of INNO PLAN: 

 

● Patient DICOM dataset loading and visualization* 

● Data (DICOM, .stl files) input; Data (.stl file) output for manufacturing; Surgical report (drilling 

protocol .pdf) output. 

●  Nerve tracing 

● Virtual crown(s) positioning 

● Virtual implant placement 

● Collision detection 

● Patient treatment plan creation  

● Surgical guide design and creation 

● Surgical protocol design and creation 

● Modeling of provisional crowns and custom healing abutments 

● Project information management and sharing 

● Designed surgical guide data can be exported to a third-party system for manufacturing** 

 

 

Note! 

The software is not intended for diagnosis, please use the software offered by the Computed 

Tomography Scanner manufacturer, on which scanning was performed for the diagnosis and expert 

opinions. The software does not apply any compression, modifications, or adaptation to the DICOM 

files and model surface scan STL-files during their upload, alignment, design, and export. 

 

 **Paid option 

 

Note! 

  

Note! The software as medical device has no patient contact 
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 Indications for Use 
 

INNO PLAN is stand-alone software designed for trained qualified dental practitioners, including dentists and 

dental technicians.  

 

The software can be used to visualize a patient’s medical image dataset output in DICOM format from third-

party CT/CBCT scanners. 

 

INNO PLAN is intended for use as a pre-operative tool for the dental implant(s) positioning based on the 

CT/CBCT image dataset aligned to optical 3D surface scan(s) and for the surgical guide planning result file 

creation. The surgical guide can be manufactured using a planning result file when used as input to 3D 

manufacturing systems.  

 

3D manufacturing is out of INNO PLAN software control, depends on many external factors and lie within the 

sole responsibility of the user. 
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1.1 System hardware and software requirements 

 

 Minimum System Requirements Recommended 

OS 
Windows 7 PRO  

Mac OS 12 and higher 

Windows 10  Home 

Windows 10  PRO 

Windows 11 

Mac OS 12 and higher 

Central Processing 

Unit (CPU) 
 Intel Core i5 or higher 

Memory (RAM) 4GB 8GB and more 

Graphics Card 
Any discrete or integrated graphics card 

supporting OpenGL 3.2 
A dedicated NVIDIA 2GB or more 

HDD 3GB of free space 100GB of free space or more 

Monitor resolution 1600 x 900 pixels 1920 x 1080 pixels or higher 

 

1.2 Network Settings 

 

Note! 
In order to identify user account, import/export order forms, share INNO PLAN projects and 

communicate with customer partner(s), personal computer must be connected to the Internet. 

 

Internet connection is required for the support, help and training provided by Customer Support Service. 
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Step 1 

Open download directory on website 

(cowellmedi.com), then click on the appropriate 

download link. Start installation process manually by 

executing the loaded INNO PLAN Setup file on personal 

computer. 

 

Step 2 

Choose language settings and click Next to move to the 

next step 

 

Step 3 

Click Next to move to the next step 

 

http://cowellmedi.com/
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Step 4 

Browse for app location and click Next to move to the 

next step 

 

It is recommended to locate main INNO PLAN folder in 

the "C:" drive root 

 

Step 5 

Select the additional tasks you would like setup and click 

Next to move to the next step 

 

For not experienced user it is recommended to choose 

all options 

 

Step 6 

Click Install to continue with the installation 
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Step 7 

Click Finish 

 

Step 8 

Fill in the E-mail for Authorization and click Next 

 

Step 9 

If you are new user fill up the registration form. 

 

It is recommended to choose option  

“I want to receive promotions, an overview of new 

products and features”. 

It is recommended to enter phone number. 
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Step 10 

Press OK, then software will be automatically closed. 

Please check your e-mail. 

 

Step 11 

Open your inbox e-mail folder, save attached key-file to 

a hard drive, open it by double clicking to complete a 

registration process 

 

 

 

Optionally  

you may specify a path to the saved key file using the 

Registration Form of INNO PLAN app: open "I have a 

Registration Key File" tab > "Browse" tab, choose saved 

Key-file in the folder and press OK;  OR copy-paste info 

from key-file as a text to the appropriate text-field 

 

 

Note! 
Key file(s) “Library” folder and other important information are located in the folder "INNO PLAN" 

(C:\Users\”user name”\AppData\Roaming\INNO PLAN) for Windows 
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If the INNO PLAN License Key file is not received after registration process, check the SPAM and other folders for 

incoming messages in your specified email box.  

 

Note! 
The INNO PLAN License Key file is "attached" to the specified email address and hardware ID of 

the PC from which registration was done. 

 

Warning! 

The INNO PLAN License Key file should not be copied and used with another PC. In aim to protect 

the user's personal information and prevent thefts, the key file will activate app installed only on 

the PC from which registration was done. 

 

One email address maybe specified for unlimited quantity of PC (home, work, office etc.) 

Only an e-mail owner able to control INNO PLAN License Key files transfers. 

 

The INNO PLAN Settings menu enables user to register several accounts, attached to different e-mail addresses. 

In case of several accounts are registered on one PC the “Select user” window appears. 

Check paragraph Setting to know how register new or additional users. 

 

If your browser automatically converts key-file to text - copy an appropriate string with the code to bookmark "I 

have a registration key-file" 

The window shows all available user accounts. 

Please select the one you want and press OK. 

 

UPDATE 
 

To check the current version of the software click the "Help" button, then select "About 

application" line 

 

If an update is available, the "Update Application" menu pops up automatically when the software starts up. Click 

"OK" to update (recommended), or click "Cancel" to continue to work with the current version. 

 

If the update does not occur, or it gives you an error, reinstall the software by clicking the link in the update 

dialog window. 

 
 
  

Note! 

Software installation package or update package is a secured deliverable package. This secure 

deliverable package is uniquely encrypted and key-hashed to ensure the integrity and 

authenticity of its origin. 
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The INNO PLAN user interface enables users to visualize the patient's DICOM dataset using the Coronal, Sagittal, 

Axial, Panoramic, Rotating Slice and 3D view in corresponding windows. 

MPR and Panoramic display can be used to generate interactive slices in free, oblique planes. 

3.1 Multi-Planar Reconstruction (MPR) Display 

 

The software automatically provides multi-planar windows (coronal, sagittal, and axial) and 3D view. This Multi-

Planar Reconstruction can be used to work on any spatial plane to obtain different types of high-quality 

diagnostic images obtained from 3
rd

 parties medical CT or CBCT scanners. 

 

 
 

 

 

 

1 Multi-Planar Reconstruction button 

2 Axial window 

3 Slider to view the whole sequence of axial images 

4 Coronal window 

5 Slider to view the whole sequence of cross-sectional images in coronal plane 

6 Saggital window 

7 Slider to view the whole sequence of cross-sectional images in saggital view 
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PLANE-AXIS NAVIGATION  

1 Center of the axes intersection for moving 

2 Bulky part of axis for parallel movement of the plane 

3 Behind bulky part of axes for 2D view rotation 
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HOW TO ADJUST THE PLANES 

 

 Free adjustment of the view by moving the center of the crossed planes 

 To move the center of the view axes intersection, put the cursor on it, then left-click and drag. The intersection 

of the view axes will move within the chosen plane. This movement will be synchronized with the change in slice 

depth in other MPR windows. 

 

Quick adjustment of the view by clicking the desired point 

To move the center of the crossed planes, put the cursor on the desired position and double left-click on it. The 

center of the axes intersection will move to the selected point immediately. 

 

Quick adjustment of the view by clicking the implant image or name 

The double left-click on the implant image or implant name in the implants list enables users to set up the 

coronal axis in the same position with the implant axis and move the center of axes intersection to the implant 

reference point. 

 

Adjustment of the oblique view (plane rotation) 

To rotate the plane, put the cursor on the plane line of the corresponding plane, behind bulky part, left-click, 

hold and rotate it. The plane will rotate around the center of the crossed planes. By adjusting the only one plane, 

the other two views in oblique multi-planar will be generated automatically. 

 

Zoom in/out  

Zoom in/out the views by holding down the right mouse button and moving the mouse forward or backward. 

 

2D view rotation 

To rotate the 2D view, put the cursor on any point of the desired window, press and hold down the left mouse 

button and rotate the object. 

 

 

MOVEMENTS OF THE PLANES 

 

Parallel movement of the planes 

To provide the parallel movement of the plane, put and hold the left mouse button on the bulky part of the 

indicator line of the plane and drag it. 

 

Move the plane by scrolling the mouse wheel  

Put the cursor on any point of the MPR window, and then scroll the mouse wheel. 

 

Moving/dragging views in windows 

To move a view in a 2D or 3D Window, press and hold down the mouse wheel, then move the object within the 

selected window. Without a mouse - press and hold the Space button on a keyboard, and then move an object 

within a selected window. 

  

Hint Use the "head" icon in the corresponding window to see the orientation of scans 
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3.2 3D Rendering Window (Volume) 

 

The 3D volume rendering view can be used to visualize 3D data generated by X-Ray and optical scanners in 

three-dimensional space in aim to simplify the spatial orientation and object placement control. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

1  MIP mode  (Maximum Intensity Projection) button 

2  ISO mode (Isosurface) 

3   Slider to adjust the DICOM rendering optical density threshold. 

4  Maximize or minimize 3D Volume Rendering Window button 

5  Visualization panel  

6  Settings button of the 3D Volume Rendering Window 

 

 

 

Нint Press appropriate arrow near 3D head icon for quick set of 3D view 
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SETTINGS MENU OF THE 3D VOLUME RENDERING WINDOW: 

 

 

 

 

 

 

   

A DICOM opacity slider 

B Buttons of  toggling the visualization of the implant, sleeve, 

drill or abutment 

C Objects opacity threshold settings 

D Axis planes visualization settings 

E Planes button 

F Axis button 

G 
Buttons of switching between low, medium and high-

performance graphics settings, depending on the customer PC 

graphics card processor capacity 

H Color indicator to change the background colour of 3D 

window 
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3.3 Panoramic Mode 

 

Serves for general review of the maxillofacial region and allows users make expanded evaluation of the 

implant(s) position 

 

 

 

 

  
1 Switch to PANO mode button  

2 Axial Window  

3 Yellow dots for editing existing panoramic curve  

4 Add new Panoramic curve button  

5 Indicator Line of the panoramic slice 

6 Multislice Window 

7 Numerical value of the angle of inclination 

8 
Slider in Panoramic Window to change the panoramic 

curve thickness 

9 Number of slices of Multislice Window 

10 Settings menu of Panoramic Window 

11 Control panel of Panoramic Window 
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PANORAMIC CURVE  

 

 The Panoramic Curve identifies the dental arch position.  

 

 

Put the mouse cursor over the image and draw new panoramic curve using the left mouse button by placing 

points one after another on the arch, then double-click to finish tracing. In case of misplacement, move the dots 

by clicking with the left mouse button on each yellow dot and dragging it into the right position. 

 

The Indicator Line (5) of the panoramic slice appears in the axial and in panoramic window. Put the cursor on the 

Multislice Window (6), scroll the mouse wheel to move the indicator line along the panoramic curve to see the 

desired cross-sectional slice(s).  

 

Hint 

Quick adjustment of the view. To move the indicator line, put the cursor on the desired area in axial 

or in panoramic view and double left-click on it. The indicator line of the panoramic slice will move 

to the selected point immediately 

 

To adjust the inclination of the cross-sections in the panoramic view click on indicator line and tilt it. The 

numerical value of the angle of inclination (7) will appear near the indicator line. 

 

Click and drag the slider in Panoramic Window to change the panoramic curve thickness (8). 

 

The default settings for Multislice window (6) assume three separate cross-section images with distance 

increment of one millimeter. The number of slices can be increased to five and reduced to one (9). 

 

 

  

Hint 
The best area where to place the curve is in the half of the length of teeth roots, where the canals are 

going to be good markers for the curve tracing 

Note! 
The angle of inclination will be indicated correctly only if the occlusal plane of chosen jaw is 

parallel to axial plan 
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SETTINGS MENU OF THE PANORAMIC WINDOW: 

 

 
 

 

 

 

 

 

CONTROL PANEL OF THE PANORAMIC WINDOW: 

 

 

"Add Panoramic Curve" button 

 

Click on the Panoramic View list button to choose initial or created panoramic view(s) 

 

Click on the button to switch between Narrow or Wide mode 

 

Click on the button to add the panoramic image to Surgical Protocol 

 

"Delete Panoramic Curve" button 

A Image opacity threshold 

B Implant visualization button 

C Sleeve visualization button 

D Drill visualization button 

E Abutment visualization button 
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3.4 Rotating Slice Window 

 

The main purpose of the Rotating Slice View is visualization of tissues around the implant for final control and 

precise correction of the implant and sleeve position.  

 

Double click on an implant in 2D, 3D or implant list to adjust rotational slice axis along implant axis. 

 

To rotate the image around the Implant axis, put the cursor on any point of the Rotating Slice window and scroll 

the mouse wheel or click and drag on the right part of the window. 

 

 

 

 
 

 

 

1 
Open Slice button to open the Rotating Slice 

Window 

2 Slider to rotate the image around the Implant axis 
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3.5 Buttons and Basic Functions 

 

 

 

1 INFO panel 

2 Tool panel 

3 MPR Visualisation panel 

4 Settings menu button 

5 Tab panel 
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INFO PANEL 

 

The INFO panel displays information on the customer name, customer email address and registration number, 

patient's name, patient's date of birth and gender, CT scan data. 

 

 

 TOOL PANEL 

 

The Tool Panel basically consists of buttons customer needs to manage the case, set up view, make a 

measurement, purchase exports, etc. 

 

 

Click the New Project / Load DICOM button to upload DICOM data 

 

Click the Open Project button to open the existing project 

 

Click the Save Project button to save project 

 

Click the Open Recent Projects button to open the list of the recent projects 

 

Click the Cloud Service button to download projects from cloud storage or manage 

them 

 

Click the Save or Send to cloud button to save the created project to cloud or share it 

with others 
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Click the Edit Notes button to note an information 

 

Click the Take Snapshot button to take a snapshot 

 

Click the Undo button to cancel the last action 

 

Click the Redo button to reverse the last Undo. Used only after Undo. 

 

Click the Switch to MRP mode button to  

 

Click the Switch to PANO mode button to edit or trace the panoramic reconstruction 

curve 

 

Click the Open Slice button to open the Rotating Slice Window 

 

Click the Reset Views button to reset view settings to default 
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Click the Measure Distance button to perform distance measurement 

 

Click the Measure Angle button to perform angular measurement 

 

Regular and Time-limited exports balance 

 

Click the Purchase Exports button to order and purchase the export packages 

 

Help button opens app-specific help sections or links when clicked 

 

Click the Settings button to open the Settings Menu 

 

Click the Order Form button to fill out the digital order form 

  

Click the Quick Pass button to send the current project to previously specified email 

address 

  

Click the Backup Now button to save the intermediate modifications to the backup file. 

The Indicator below used for autosave also. 
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 MPR VISUALIZATION PANEL 

 

 

Click the button to enable or disable the visualization of the DICOM 

 

Click the button to enable or disable the visualization of the STL surface 

 

Click the button to enable or disable the visualization of the Nerve Tracing  

 

Click the button to enable or disable the visualization of the Crown  

 

Click the button to enable or disable the visualization of the Digital Implant 

 

Click the button to enable or disable the visualization of the Measurements 

 

Click the button to enable or disable the visualization of the Surgical Guide 

 

Click the button to enable or disable the visualization of the Axis 

 

Click the button to enable or disable the visualization of the Patient Data 
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 SETTINGS MENU 

 

This menu allows setting the preferences for the software. 

The following settings can be set from this page: 

 

 
 

 

 

 

1. Interface tab  

 

Set : 

- auto-updates mode; 

- max weight of imported STL; 

- auto-block of objects movement; 

- objects collision detection settings; 

- language; 

- Teeth Numbering system; 

- register a new user or delete current user. 

 

 

 

 

  

Note! 
When collision function is selected, the software checks the collisions of the objects automatically. If 

collision is detected, the triangular sign "Attention" will appear 
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2. MPR View  

 

Set:  

- outline thickness of elements in MPR mode; 

- slice width adjustment in Rotation Slice Window mode; 

- default background color of 3D window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Panoramic Views 

 

Set: 

- size of panoramic points; 

- outline thickness of Pano mode elements; 

- distance between cross slices adjustment. 
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4. Library  

 

Set: 

- Library auto-update mode 

- Initial V-factor settings 

- Custom sleeve hole deepness 

- Notification “original finishing drill is not loaded in the local library” settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Mesh Edit 

 

Mesh Edit setting has the checkbox "Assign a new color to edit object". When it is selected, it determines the 

color of the newly edited STL file. If the checkbox is not selected, the color of the original STL file is duplicated in 

the edited version.- 
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6. Model  

 

Set default values of the model that will be automatically applied when the Model Builder is accessed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Surgical Guide  

 

Set: 

- Surgical guide default settings; 

- Defaulf settings of guide surface mesh grid size. 

See chapter "Surgical Guide" for a more detailed explanation. 
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8. Cloud Service  

 

Set: 

- e-mail for Quick Pass Email; 

 - Cloud directory; 

 - Duration for Cloud Basket Storage, mail check and local copied files; 

- auto save logs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Additional  

 

Set: 

- Implant and Abutment Axis parameters 

- Split cord default diameter 

- Data directory 

- Additional parameters checkboxes 
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10. System Info 
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TAB PANEL 

Tab panel helps users navigate through the patient's case 

 

 

DICOM management 

 

STL surface management 

 

Nerve tracing 

 

Crown design 

 

Digital Implant, Sleeve, Drill, Abutment  management 

 

Anchor Pin management 

 

Surgical Guide design 

 

Modeling 
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Step 1 

Click the New Project / Load DICOM button which is a way either to import a dataset from a 

selected source  

 

  

 

Step 2 

In the appeared window to download data, select any 

object from the following: 

 

- FOLDER WITH DICOM DATA 

- MULTI-FRAME DICOM FILE 

- SINGLE-FRAME DICOM FILES SET, ONE FROM THE SET  

- DICOMDIR FILE 

- ZIPPED DICOM FILE 

 

 

 

 

 

 

Step 3 

Click on "Open" 

  

Hint 

To see DICOM-files without extension choose "All files" option. 

Ensure to select the correct study and series by comparing them with the patient name in the 

CT/CBCT data selection dialog. After you have uploaded the relevant dataset, it is displayed in the 

processing window. 

 

 

Step 4 

Process the uploaded CT/CBCT dataset: 

 

- adjust the image opacity threshold by dragging the corresponding slider; 

- with the cropping tool, remove disturbing or unrelated parts of the CBCT/CT scan by left-clicking, holding and 

dragging the purple cropping box inside the windows and area outside the box will be deleted. 

- In case of DICOM is displayed with an incorrect orientation upside down, turn it so that the Maxilla is on top 

and the Mandible is on the bottom using rotation slider.  

-If necessary to reload image in other contrast quality, apply changes and click Reload button.  

 

Then click "OK". 
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PROCESSING WINDOW SETTINGS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1 Image opacity threshold slider 

2 
MIP mode (Maximum Intensity Projection) and ISO mode 

(Isosurface) switching buttons 

3 Cropping box 

4 Rotation slider 

5 Reload button 
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4.1 DICOM "Cutting" 

 

The 3D and 2D visualization of the CT/CBCT scan of the patient may be "cut off" by an overlay of the dark mask 

on a selected area of the DICOM. Created masks can be turned on and off to hide and display fragments of 

CT/CBCT. This feature is most in demand for working with 3D rendering. 

 

Step 1 

Setup the 3D image position.  

 

 

Step 2 

Click on the "Cut" button in DICOM directory in the right part of the screen.  

 

 

Step 3 

Identify the area on which the DICOM mask is going to be 

cut: 

- draw the borderline by placing points one after another 

around the cutting area. Continue to draw the curve that goes 

back to the starting points and then double-click to finish 

selection. 

 

 

 

 

 

 

 

Step 4 

Either click on the  

"Cut inside selected area" button 

to cut inside  

 

OR 

 

"Cut outside selected area" button 

to "cut" outside. 

 

 

 

 

 

 

 

Step 5 

Press the "Save" button to save the created DICOM mask and mask name will appear in the list in DICOM 

directory on the right part of the screen. Optionally, it is possible to change the name of the saved DICOM mask 

by pressing the "Edit Title" button. During the design process choose any saved DICOM mask by left-clicking on 

it. 
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4.2 DICOM to STL Conversion 

 

       Step 1 

Adjust 3D rendering, using optical density threshold. Click on the "Convert to Surface" button to start the 

conversion process of the DICOM file to STL surface.  

 

 

       Step 2 

Adjust, if necessary, 3D rendering optical density threshold by clicking “+” and “-“ (C) buttons on control panel. 

 

 

       Step 3 

Adjust the size and position of the working area which is 

outlined by a purple cube lines.  

 

Expand or compress the working area by left-clicking, 

holding and dragging the purple converting box of the 

working area.  

To rotate the whole working area left-click, hold and drag 

the red, yellow and green marks.  

To move the whole working area left-click, hold and drag 

the square dot in 2D or circle in 3D, located at the central 

part of the converting box.  

 

 

 

 

       Step 4 

Click on the "Convert" (A) button  

 

 

 

  Step 5     

 If the quality of the created surface is acceptable, click on "Move to 

Project” button (B). If no, click Continue Editing (D) button to 

continue editing. 

 

 

 

 

 

 

Note! 
The final view of the converted surface depends on the pre adjusted 3D 

rendering threshold 

Hint 
Clicking on “Continue Editing” (D) opens the segmentation 

editor (see Annex H) 
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Surface files in .stl or .obj format can be imported and implemented into the project. Jaw surface scans can be 

obtained using third-party intraoral or laboratory optical or laser scanners. 

Alternatively, a plaster model of the patient's jaw can be scanned with a CT/SBCT scanner and the obtained 

DICOM file can be converted to an STL surface (see APPENDIX B - Dual Scanning Technique). The accuracy of 

the dual scanning technique is in doubt. 

 

STL TAB MENU 

 

 

1 
Color indicator: click on it to change color of 

STL surface 

2 
Name of STL surface: right click to change name 

of STL surface. 

3 Toggling visualisation button 

4 Lock on/off button 

5 “Delete STL surface” button 

  

1 STL tab button 

2 STL surfaces list 

3 Load surface from file button 

4 Load surface from library button 

5 Load surface from DICOM image button 

6 STL Opacity threshold  

7 Align button 

8 Edit button for opening Editor menu 

9 Export to file button  

10 Copy to button 
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Step 1 

Click the STL Surfaces button in the tab panel on the right part of the screen.  

 

 

 

Step 2 

Click on "STL+" button on control menu 

Select the appropriate STL file on your computer and Press OPEN 

 

 

 

Step 3      

In modal window select: 

- Object type 

 

- Object location 

"Align to DICOM or to another STL file" checkbox  

OR 

"Put to the center of coordinates" checkbox to place the STL model at 

the center of coordinates 

OR 

"Put to original coordinates" checkbox to place STL model at the 

original coordinates.  

 

- If necessary, select “Fix object`s surface after importing” checkbox 

 

 Press OK.  

 

  Step 4 

Make an Alignment of uploaded file, If necessary. 

 

 

 

Hint 
The "Put to original coordinates" is the most convenient mode to import several STL surfaces 

previously aligned together in the third party CAD programs. 

Note! 

If the amount of triangles in an STL file is exceeding a threshold (400000 triangles on default,  

may be adjusted in the settings menu), the software would propose to reduce the number of 

triangles in the file 

Hint 

Click on the "Group" button in the STL list and select two or more STL file in the appeared window 

to group them for further design and alignment and press "OK".  The main purpose of this feature 

is an ability to move selected and grouped up STL objects together. The mutual position of the 

grouped up STL surfaces remains unchanged. 

STEPS OF IMPORTING .STL-FILE:  
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5.1 Alignment 

 

ALIGNMENT MENU 
 

 

 

 

 

 

 

  
1 Pairs of points 

2 List of pairs points numbers  

3 Align by points button 

4 Auto checkbox 

5 Full automatic alignment for STL surfaces 
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ALIGNMENT PROCESS 

 

Step 1 

Mark: 

"Align to DICOM or to another STL file" checkbox in modal window after importing STL 

OR 

Click “Align” button on workpanel 

 

 

Step 2 

Select the surface with which you want to align. Bring the two images into view so that they are similar. The 

alignment can be used to DICOM or to another STL file. 

 

 

Step 3 

At opened alignment window align objects using the possible instrument depending on type of data. 

 

The alignment of DICOM to STL can be achieved 

manually (Align by Points)  

Pick a point on DICOM surface as a landmark by left-

clicking, then click a point on the corresponding region 

of the STL surface.  

Select at least 3 equal regions and click on the "Align 

by Points" button.  

 

 

The alignment of STL to STL can be achieved manually (Align by Points), automatically (Fully Automatic 

Alignment), and in mixed ways.  

 

Use the “Fully Automatic Alignment” button to 

automatically operate. This tool can work when the 

surfaces have similar parts or similar mesh. When the 

surfaces are different use mixed alignment: first 

manually and in the end fully automatic.  

  

 

 

Step 4 
Check and adjust the result of alignment manually:  

On MPR mode click on STL surface center (the square point which is marked in color of corresponding STL 

surface) and drag it or click on the STL surface borderline and tilt it. 

 

 

 

 

To realign STL files or STL and DICOM files press on "Align" button on control panel of STL tab. 

 

  

Hint 

Using the Auto checkbox the program 

achieves the highest possible accuracy 

in matching based on the selected 

points. 

Note! 

Note! “Fully Automatic Alignment” 

button is not available in Windows 7 

operating system. 
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IMPORTING AND ALIGNING A GROUP OF PRE-ALIGNED IN EXTERNAL SOFTWARE  STL FILES 

 

Step 1 

Click “Align” button on workpanel 

 

 

Step 2 

Select the required group of STL files. 

 

 

Step 3 

In the STL file list group the uploaded files.  

 

 

Step 4 

Turn off visibility for all but one STL file from the group, using the dedicated button in the STL files list.  

 

 

 Step 5 

Press the "Align" button to align the group of STL files with the necessary DICOM or STL. 

  

 

 

 

  

Note! The selected group of STL files will automatically be positioned in their original coordinates. 

Hint 
To group imported files, hold down Ctrl and click on the names of the STL files in the list.   

Use Shift to group imported files into the second set of STL files 
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 NERVE MENU  

 

   

1 Nerve tab button 

2 Draw new nerve button  

3 Color indicator. Click on it to change color of nerve 

4 Nerve diameter window 

5 Show On/Off button 

6 Lock On/Off button 

7 Delete button 
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Step 1 

Select MPR mode. Setup the 

slice planes to visualize nerve 

canal clearly in axial, cross-

sectional and sagittal view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2 

Click on "Nerve" button on tab panel on the right part of the screen and then "Draw new Nerve" button on the 

workflow panel. 

  

 

Step 3 

Trace nerve canal: 

by using the left button of the 

mouse points one after another 

from frontal part to distal part 

in the Sagittal window;  

 

OR 

 

by clicking and scrolling 

through the Cross-sectional 

view.  
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Step 4 

Complete the operation:  

 

by double-clicking the left mouse button;  

 

OR 

 

by clicking the "lock" button in the nerve tracing menu panel. 

 

 

 

Warning! 
Make sure that the nerve is correctly traced.  Always maintain an appropriate safety distance 

to the nerve canal 

Warning! 
The pathway of imaged nerves is for display only, location accuracy of the traced nerve is not 

tested, and pathways of imaged nerves can not be used as sole information for the clinician 

to make clinical decisions 
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WORKFLOW PANEL OF CROWN MODE 

 

 

 

   

1 Crown tab 

2 Crowns list 

3 Place new Crown or Tooth button 

4 Move Crown or Tooth Mode button 

5 Edit button  

6 Export button 

7 Copy to button 

8 Replace button 

9 Opacity threshold 

10 Scale slider 
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Step 1 

Select MPR mode. Set up the slice planes to visualize the tooth/teeth position to be planning in axial, cross-

sectional and sagittal view. 

 

 

Step 2 

 

Click on "Crown" button in the tab panel on the right part of 

the screen then "Place new Crown or Tooth" button on the 

workflowpanel. 

 

 

 

Step 4 

 In appeared "Select Position" window select: 

 

 the crown or tooth mode;  

 

 click on the desired tooth in the virtual schem, and 

the virtual crown or tooth is going to appear in 

the pre-set area.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Hint 

Click the “Export” button to to 

export the crown or teeth as stl-

file to specified folder on the PC 
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Step 5 

Manage the selected crown/tooth: 

 

 Change the tooth position in 

axial, cross-sectional and sagittal 

view by 

 clicking on and holding central 

square and dragging it  

OR 

 clicking on and holding the line 

tilt it. 

 

 change the tooth position in 

3D mode, by clicking on the tooth. 

Left-click, hold and drag this green 

line to tilt the tooth. Right-click, 

hold and move the mouse forward 

to increase the tooth size or move 

the mouse back to decrease tooth 

size. 

 

 Change the size of the 

tooth/crown using "Scale" slider.  

 

 Replace the tooth/сrown using 

the “Place new crown/tooth” button. 

 

 

 Reposition the tooth/сrown using the “Move Crown/Tooth Mode” button. 

 

 Edit a crown/ tooth with the Editor, by clicking the "Edit" button (see Annex G). 

 

 

 

 

Step 6 

Click on "Lock On/Off" button in the "Crown" tab panel to lock in the required settings. 

 

 

 

 

  

Note! 
Use the Shift key for group adjustment of crown opacity 

and scaling. 
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The software allows users to perform implant planning using Panoramic, MPR or Rotation Slice mode.  

The general idea of the planning concept is: - the implant is the primary object; - the drill tip is connected to the 

implant apex (with adjustable v-factor shift); - occlusal surface of the sleeve is connected with a drill stopper 

surface (with adjustable Spacer). 

 If the drill length is changed, the sleeve position will be changed equally, increasing and decreasing sleeve 

offset. 

 

 

WORKFLOW PANEL OF IMPLANT MODE 

  

1 Implant tab 

2 Implant list 

3 Place new Implant button 

4 Replace implant button 

5 Occlusal diameter 

6 Length 

7 Rotation implant slider 

8 
Set Parallels to Current button to align the 

parallels of the implants to the desired implant 

9 
Visualisation of Sleeve, Drill, Abutment, Analog 

buttons 

10 Replace Drill button 

11 Drill submenu 

12 Protocol menu button 

13 Sleeve submenu button 

14 Abutment submenu button 

15 Analog submenu button 
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Step 1 

Select MPR or Pano mode. Set up the planes-axis to visualize the further implant position to be planning in axial, 

cross-sectional and sagittal view. 

 

 

 

Step 2 

Click on "Implant" button in the tab panel on the right part of the screen. Click on "Place new Implant" button. 

 

 

 

Step 3 

At the appeared window, choose the "implant", "sleeve", 

"drill" and, if necessary, "abutment" corresponding submenu 

by left-clicking. Options choosing implants: 

 Custom implants 

 Implants from library   
 

 

 

Step 4 

Manage implant position: 

 in axial, cross-sectional and sagittal view just click on and hold square mark at the 

occlusal line of the implant and drag it, or click on and hold the implant contour line and tilt 

it. 

 in 3D mode right-click on the implant. In the modal window, click the        button The 

green and blue round lines are going to appear. Left-click into green circle, hold and move 

implant, or pull green circle to tilt the implant. Left-click, hold and move the blue circle to 

rotate the implant. 

 clicking the Set Parallels to Current button aligns the parallels of the implants to the 

desired implant. To perform this operation, select the implant to be aligned and then press 

the Set Parallels to Current button and select the implants to be aligned. 

Fill in the value of the Max deflection angle (deg) and confirm the selection by pressing "OK". 

 

 

 

Step 5 

Manage implant parameters: 

 change the size of the implant in windows 5 (D-diameter) and 6 (L-length) by clicking on the number and 

scrolling the mouse wheel, or writing the number into the appropriate windows, or using the arrows. 

 set the Implant, Drill, Sleeve, and Abutment settings up by clicking on "Replace Implant" button (4). 

 

Click on "Lock On/Off" button in the "Implant" tab panel. 
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Step 6 

In "Drill" submenu set up the drill diameter "D" (A), drill length "L" (B), 

drill V-factor (C), and offset (E). The drill spacer "S" (D) is an option to 

add the regulated space between stopper of the drill and contacted 

surface of the sleeve to change a position of the sleeve and decrease 

the sleeve offset during digital implant planning. 

 

To reset / rechoose drill, press button Replace Drill (F) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 7 

Click on the "Sleeve" submenu and check the model of the sleeve (A), 

offset height "O" (B).  

 

Note! 
The initial rotational position of the sleeve is related to 

the rotational position of the implant 

 

To rotate a sleeve separately from implant,  click on the slider and 

drag it (C) to rotate a sleeve by an angle multiple of 15, 30, 60, 90 

degrees, choose the rotation angle checkbox "R" and select one of 

the four options: 15, 30, 60, 90 (D).  

To change the current sleeve, click on the "Replace Sleeve" button (E). 

 

 

 

 

 

 

 

 

 

 

 

Step 8 
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Click on the "Abutment" submenu in the right part of the screen and check the 

model of the abutment (A), collar height "Hc" (B) and extension angle "Ae" (C).  

The initial rotational position of the abatment is related to the rotational 

position of the implant. 

To make a rotation of the abutment, click on the slider and drag it (D). If 

library abutment has specified information about rotation grid, its rotation will 

available with this grid only. Fine rotational adjustment will be available 

together with the implant. 

To change the current abutment, click on the "Replace Abutment" button (E). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 9 

Click on "Lock On/Off" button in the "Implant" tab panel.  
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PROTOCOL 
 

The "Protocol" submenu (A) allows to review and control the drilling 

sequence.  

Clicking the Protocol button with the left mouse button: 

1) the sleeve positions blocked for current drill. That drill will 

be marked as a M – master drill. In depending from 

preferable drilling protocol, the Master drill may be the Final 

drill in the drilling sequence or intermediate. 

2)  displays a submenu with drills sequence tab and additional 

buttons and parameters including drill diameter "D" (B), drill 

length "L" (C), drill V-factor “V” (D), drill spacer "S" (E) and 

offset “O” (F). A new drill bit can be added by left-clicking 

the (G) button. The current drill bit can be replaced with the 

(H) button.  

After adding a drill, its parameters can be adjusted in the value 

windows. The sequence of drills can be easily arranged by dragging 

them to the corresponding tabs. 

 

The drilling sequence can either be pre-set within the drilling library 

and automatically logged in the protocol or can be manually set. 

 

Edit the parameters of each drill in the protocol by selecting the respective drill and setting the values for drill 

diameter "D," drill length "L," drill V-factor “V,” and drill spacer "S."  

 

Use drag`n`drop to change the sequence of drills in the protocol, including the Master-drill. 
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8.1 Options of choosing implant elements 

 

CUSTOM ELEMENTS 
 

Placing an simplified implant from the constructor of Custom Implants 

 

 

  

1 
Implant, Sleeve, Drill, 

Abutment, Analog tabs 

2 Custom implant  

3 Parameters of Implant 

4 
Add to all visible implant 

checkbox 

5 Place as current Implant checkbox  

6 Use match list checkbox 

7 V-factor and Offset inputs 
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Step 1 

Click on the "Implant" submenu and select "Custom Implant" option on the list. 

 

 

Step 2 

 Choose the implant color and enter relevant dimensions for "Occlusal Diameter" (D), "Apical Diameter" (d), 

"Implant Length" (H) and "Interface Edges (Angles) Count".  

 

 

 

Step 3 

Mark the "Place as a last Implant" checkbox to save settings for the next implant(s) to be placed. To restore 

settings for the next start of the software, mark the appropriate checkbox in the lower right of the submenu 

window. 

 

 

 

Step 4 

Add the V-factor depth by scrolling the mouse wheel, or writing the number, or by clicking on the arrows. 

Increasing or decreasing the value of the V-factor leads to the drill tip shifts down or shifts up relative to the 

implant apex. 

 

 

 

Step 5 

The same can be performed for custom sleeves. Click on the "Sleeve" submenu, select "Custom Sleeve" option, 

choose the sleeve color and enter required dimensions for "Sleeve Inner Diameter" (d), Sleeve Outer Diameter 

(D), Sleeve Height (H), Sleeve Edge Diameter (De), Sleeve Edge Height (He). 

 

 

 

Step 6 

Custom Drills. Click on the "Drill" submenu, select "Custom Drill" option, choose the drill color and enter 

required dimensions for "Drill Length" (L), "Drill Diameter". 

 

 

 

Step 7 

Click on the "Abutment" submenu, select "Custom Abutment" option, choose the abutment color and enter 

required dimensions for "Collar Height" (Hc), "Abutment Angle" (A). 

 

 

 

Step 8 

Press "OK" and select the tooth position. 

 

 

 
 



. 

55 

 

To place preloaded elements  

 

Step 1 

Click on the "Place new Implant" button or on the "Replace Implant" button. 

 

 

 

Step 2 

 In the appeared menu choose the 

implant manufacturer name, implant line 

name, and implant size. 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3 

Click on the "Sleeve" submenu, choose the sleeve manufacturer name and sleeve line name. 

 

 

 

Step 4 

Click on the "Drill" submenu, choose the drill manufacturer name, drill line name, and drill size. Set up "V-factor" 

depth, then press "OK". 

 

 

 

Step 5 

Click on the "Abutment" submenu, choose the abutment manufacturer name, abutment line name, and 

abutment size and type. 

 

 

 

Step 6 

Click on the "Analog" submenu, choose the analog manufacturer name, analog line name, and analog size and 

type. 

 

 

 

Step 7 

Check the implant position and press "Add Drill" to add a final drill to the drilling list. 
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The pin planning using INNO PLAN has the same concept as an implant positioning.  

 

 

WORKFLOW PANEL OF PIN MODE 

  

1 Pin tab 

2 Pins list  

3 Place new Pin button 

4 Place new Pin in Volume button 

5 Replace Pin  

6 
Visualisation of Sleeve, Drill 

buttons 

7 Drill submenu button 

8 Sleeve submenu button 
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Step 1 

Select MPR mode. Setup the slice planes to visualize the further pin position to be planning in axial, cross-

sectional and sagittal view. 

 

 
 

 

Step 2 

To add a virtual pin click on "Pin" button in the workflow panel on the right part of the screen. Green transparent 

arrow will appear in Axial and Sagittal windows in an aim to show the position and direction of the pin. 
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Step 3 

Click on "Place new Pin" or “Place new Pin in Volume” button and at the appeared window, choose the "pin", 

"sleeve", and "drill" corresponding submenu by left-clicking. 

 

 

Step 4 

Click on the "Drill" submenu in the right part of the screen and set 

up the drill diameter "D" (A), drill length "L" (B), the drill spacer "S" 

as an option to add the regulated space between stopper of the 

drill and contacted surface of the sleeve to change a position of 

the sleeve and decrease the sleeve offset during digital pin 

planning (C) 

 

 

Hint 

 There are pre-set protocol with appropriate drill and 

sleeve for most of pins in the library. It is recommended 

to download appropriate drill and sleeve with pins 

 

 

 

 

 

 

 

 

 

 

 

Step 5 

Click on the "Sleeve" submenu in the left part of the screen and 

check the name of the sleeve (A). To change the current sleeve, click 

on the "Replace Sleeve" button (B). 
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9.1 Options of choosing implant elements 

 

CUSTOM PIN 
 

To place a pin that does not available on the pin library list  

 

Step 1 

Select "Custom Implant" option.  

 

 

Step 2 

Choose the pin color and enter 

relevant dimensions for "Diameter" 

(d), and Length" (H). To restore 

settings for the next start of the 

software, mark appropriate checkbox 

in the lower right of the submenu 

window. 

 

 

 

 

 

 

 

 

Step 3 

The same can be performed for custom sleeves and custom drills (see Implant settings part). Then press the 

"OK" button.  

 

 

Step 4 

To change the pin position in axial, 

cross-sectional and sagittal view just 

left-click on and hold square mark at 

the stopper-contact surface area of 

the pin and drag it (A), or click on 

and hold the contour line and tilt it 

(B). 

 

 

 

 

 

 

Step 5 

Click on "Lock On/Off" button in the "Pin" tab panel or go to the next step. 
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PLACE PRELOADED PINS  

 

 

Step 1 

Click on the "Place new Pin" button or on the "Replace Pin" button. 

 

 

 

Step 2 

In the appeared menu choose the pin manufacturer name, pin line name, and pin size. 
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WORKFLOW PANEL OF SURGICAL GUIDE MODE   

1 Surgical Guides tab 

2 Guides list 

3 Make Surgical Guide based on Prosthesis button 

4 Make Surgical Guide based on Surface button 

5 Make Stackable Surgical Guide based on Surface button 

6 Surgical protocol button 

7 Edit button 

8 Export button 

9 Copy to .. button 
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Step 1 

To start a virtual surgical guide creation click on "Surgical Guides" button in the workflow panel on the right part 

of the screen. And click on "Make Surgical Guide based on Surface" button 

 

 

 

Step 2 

At the appeared window check the STL surface position – Maxilla 

or Mandible.  

 

If direction of the surgical guide suggested by the program 

incorrectly, select the appropriate Surgical Guide orientation - 

"Maxilla" or "Mandible" manually. 

Set up the Surgical Guide settings for printing: 

A  Gap (mm) between surgical guide and supporting surface (set 

up an additional compensation value for the expansion or 

shrinkage of the guide material during the printing process. The 

settings of this parameter avoid difficulties during the process of 

placing and removing the surgical guide, and are necessary to 

compensate for scanning errors or other aggravating factors.);  

B  Thickness (mm) (surgical guide wall thickness settings);  

C Sleeve Support (mm) (set the diameter of the sleeve support); 

D  Pin Sleeve Support (mm) (set the diameter of the pin sleeve 

support); 

E Safety Diameter (mm) (set the diameter of the dental handpiece 

head safety zone around the sleeve) 

F Safety Height (mm) (set the height of the dental handpiece 

head safety zone above and around the sleeve);  

G Sleeve Gap (mm) (set the positive radial offset between a 

sleeve and surgical guide sleeve support);  

H Pin sleeve gap (mm) (set the positive radial offset between a 

pin sleeve and surgical guide); 

I  Side Angle (degrees) (set the value of the angle of the slope of the guide edge). 

 

 

 

 

 

 

  

Hint Default settings can be changed in the Settings Menu. 
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Step 3 

To identify the area on which the Surgical Guide is going to be 

supported, draw the guide borderline by placing points one 

after another around the Surgical Guide area.  

Continue to draw the curve that goes back to the starting 

points and then double-click on this line or click on the “Draw 

Curve” button. 

 

Note! 
Pull placed dots by left mouse button for 

position editing. 

 

 

Click on the "Preview Guide" button and software will go ahead 

and create the preview model of the surgical guide. 

 

 

Step 4 (optional) 

If necessary, click the "Edit Guide" button to open the Surgical Guide Edit Menu.  

 

 

  

Step 4.1 

Click “Cut Holes” button (A). 

To cut viewing windows either click on the round window button or click on 

the square window button, set up the size of the window by scrolling with 

the mouse wheel (C-D).  

The cursor is going to be round or square shape cutter, move the cursor 

over the STL surface of the generated surgical guide then left-click to make 

a hole. 

 

 

 

 

 

 

 

 

 

 

 

 

Note! 

Before generating the guide, set up the 

guide insertion path! The path of 

insertion is a perpendicular to the 

screen! So, place the STL surface in the 

appropriate position when you see 

minimum undercuts  

Note! Editing also available after guide creation finishing 
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Step 4.2 

Click “Place Support” button (A). 

To add a straight/curved support bar from the menu either click on 

appropriative buttons (B-C) or click on the square button, set up the 

diameter of the support bar (D).  

Choose one option of constructing a support bar (E-F):  

CONNECT option is used to construct a bar when it does not fully intersect 

one or more intermediate parts of the object in its middle section. This 

option is also suitable for building a support bar when one or both parts of 

the object have thin walls. 

INTERSECT option is used when constructing a bar in a way that its middle 

section fully intersects one or more intermediate parts of the object. 

Place a support bar on the guide surface and modify it by using the points 

for rotation and size adjustment. 

 

 

 

 

 

 

 

 

 

 

Step 4.3 

Select the “Place Label” button (A). 

Type in the desired text in the label field. 

Modify the desired label text depth (D) by scrolling with the mouse wheel. 

To add a label to surgical guide move cursor over the guide and left-click 

where you wish to place tag. Click on the "Concave" (B) or "Convex" (C) 

checkbox to modify the way a Label imprints on the surgical guide surface.- 
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Step 5 

Check the surgical protocol by clicking the "Surgical Protocol" button in the Surgical Guide menu on the right 

part of the screen. 

 

 

Step 6 

Check Surgical guide settings and modifications then click "Make Guide" button to achieve the final view of the 

generated guide. 

 

 

Step 7 

To move created Surgical Guide to the project press "Move Guide to Project", then in the appeared window, click 

"Yes". 

 

 

 

 

  

Note! Paid option. One export credit will be charged from your account 
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10.1 Surgical Guide Based on Prosthesis 

 

Step 1 

To start the creation of the surgical guide based on the denture click on the "Surgical Guides" button in the 

workflow panel on the right part of the screen. Click on the "Make Surgical Guide based on Prosthesis" button.  

 

 

Step 2 

At the appeared window setup the STL surface position.  

 Select the Surgical Guide orientation - "Maxilla" or "Mandible".  

 Set up the Surgical Guide settings for STL printing. 

 

 

Step 3 

Click on the "Generate Guide" button and software will go ahead and create the surgical guide. 

 

 

 

 

 

Step 4 

To move created Surgical Guide to the 

project press "Move Guide to Project", then 

in the appeared window, click "Yes". 

Click on "Export" button to save guide as 

STL-file on your computer.  

To get file of the Surgical Protocol saved or 

printed, press "View Surgical Protocol" and 

chose appropriate option. 

 

 

 

 

  

Note! The pass of insertion is doesn’t matter for guides created from dentures 

Note! Paid option. One export credit will be charged from your account. 
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10.2 SURGICAL PROTOCOL 

 

The INNO PLAN creates a surgical protocol together with the surgical guide based on virtual implant planning, 

sleeve(s) position and selected surgical drill sequence.  

 

Step 1 

Chose appropriate guide in the list of surgical guides. Click the "View Surgical Protocol" button in the right part 

of the screen to open the Surgical Protocol Window 

 

 

The following image shows an example of a surgical protocol. Positions of guide and cards with implant info are 

adjustable by pulling them with left mouse button. 

 

 
 

The surgical protocol is available per implant providing detailed information together with the images of the 

planning view. Adjust the guide position as you need. To get more info select the option "Show implant page". 

 

 
 

To add a panoramic image to the Protocol select the option "Add to surgical protocol". 
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The model design feature within the INNO PLAN software is instrumental in creating models of objects within 

the field of dental implantation. It plays a crucial role in optimizing the dental implantation process and 

comprises the following functional tools: the Model Builder, the Custom Provisional Crown, and the Custom 

Healing Abutment. 

 

 

WORKFLOW PANEL OF MODELING MODE 

   

1 Modeling tab 

2 Model Builder button 

3 
Custom Provisional Crown 

button 

4 
Custom Healing Abutment 

button 
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11.1Model Builder mode 

 
 

  

1 Edit button 

2 Mandible or Maxilla buttons 

3 Add Base button 

4 Base boundaries button 

5 Gridsize input  

6 Inverted checkbox 

7 Gingival mask submenu 

8 Hollow model submenu 

9 Add Analogs submenu 

10 Suprastructures Cut submenu 
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Step 1 

 

 Select the desired STL file.  

 

 

 

Step 2 

Click on the "Modeling" section within the workflow panel. 

 

 

Step 3 

Activate the STL editor by clicking the Edit button. If necessary, prepare and correct any defects in the STL 

surface for modeling. 

 

 

Step 4 

The Mandible or Maxilla buttons are automatically highlighted based on the software's identification of the jaw. 

You can manually switch them if needed. 

 

 

Step 5 

Rotate the STL surface in the 3D window with respect to the base part's boundaries, represented by the 

horizontal purple lines: 

 

 Move the cursor over the STL surface while holding the left mouse button to perform arbitrary 3D rotation of 

the STL. 

 Moving the cursor outside the STL surface while holding down the left mouse button allows you to rotate the 

STL around the vertical axis. 

 Use the scrolling wheel anywhere in the rendering window to rotate the STL around an axis perpendicular to 

the screen plane. 

 

 

Step 6 

Position the Model Base: 

 Drag the green circle. between the purple lines while holding the left mouse button to position the base part 

relative to the STL surface. 

 Dragging the purple lines (this is in addition to dragging the green circle) allows you to change the height of 

the base part of the model's base. 

 

 

Step 7 

Adjust the size of the base triangles by filling in the Grid size in the digital window next to the Add Base button. 

 

 

  

Note! Model Builder exclusively operates with unclosed surfaces. 
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Step 8 

Click the Add Base button to create the model's base. 

 

If necessary, you can reverse the orientation of all 

triangles on a surface by clicking the Invert button. 

 

 

 

Step 9 

Once the model is created, the model design buttons will become available: 

 

Gingival Mask: 

 

Clicking the Gingival Mask button generates 

separate STL files for gingival masks, 

represented as purple boxes in the 3D 

rendering window (1). Select the box's 

position relative to the STL surface by 

checking the relevant checkbox. You can 

manually resize the box's sides by dragging 

and adjusting the box's boundaries in the 3D 

rendering window or by entering the size 

value in the digital windows. Click the Add 

New Mask button to create additional 

gingival masks. 

                              

 

 

Hollow Model: 

Clicking the Hollow Model button creates internal voids in the model with specified wall thickness parameters 

and optional internal surface smoothing. 

 

Add Analogs: 

Click the Add Analogs button to add support for analog implants. You can fill in adjustable parameters on the 

control panel, such as Diameter, Bottom, and Gap. 

 

Suprastructures: 

To remove the model volume from the simplified gingival mask, click the Suprastructures Cuts button . To view 

the cut teeth area, select the Cut teeth option. 

 

 

 

Step 10 

Finalize the model creation by clicking the Make Model button.  

 

 

Step 11 

To transfer the model file and gingival mask files (if available) to the STL list, click the Move to the Project button. 

 

Note! 

Clicking the Add Base button after correcting 

the STL position and base boundaries allows 

you to reshape the model base. 
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11.2 Custom Provisional Crown Modeling 

 

 

   

1 Based on 

2 Base Contour 

3 Number of slices 

4 Preview button 

5 Apical contour slider  

6 Base & Bend contour sliders 

7 Base & Bend deform sliders 

8 Abutment/Crown visualisation button 

9 Result  visualisation button 

10 Intersection line  visualisation button 

11 Hole Diameter setting 

12 Base Gap setting 

13 Smooth Connection button 

14 Make button 

15 Remove Undercut checkbox 

16 Cut with Cylinder  buttons 



. 

73 

 

 

Step 1 

 

 Choose the necessary elements: 

 relevant STL surface. 

 implant. 

 suprastructure to be used in conjunction with the 

chosen implant. 

 crown or tooth. 

 

 

 

 

Step 2 

Click the 'Custom Provisional Crown' button in the Modeling section. 

 

 

 

Step 3 

Begin by selecting the location where the provisional crown will be based, either at the Abutment or Implant 

levels. 

 

 

 

Step 4 

Choose the Base Contour using the necessary instrument for shaping the border: Edge, Line, or Auto. 

 The 'Edge' tool: The Base Contour will be automatically generated based on the nearest surface edge to the 

set point. To set the point, left-click at the desired location, and the base contour will be created. It will be 

displayed as a red line. Double-click the left mouse button to lock the line. 

 The 'Line' tool: This tool allows manual drawing of the base contour, which will also appear as a red line. Set 

contour points by left-clicking at the necessary positions in the rendering window. Right-click can be used to 

delete points. Complete the contour drawing by double-clicking the left mouse button. 

 The 'Auto' tool is designed for the automatic placement of the base contour at any specified point location. 

To set the point, left-click at the necessary location and double-click to lock the base contour. 

 

 

Step 5 

To adjust the contour, check the 'Edit' checkbox. The line will be 

represented by a set of points that can be moved using the left 

mouse button or deleted using the right mouse button. The 

density of points on the line can be changed in the digital 

window. 

 

 

Step 6 

Choose the Number of slices by selecting one of the available positions. Slices represent meridian segments 

used for editing individual parts. The default value is 12. Increasing this value allows for more precise editing. 

 

 

Note! 

When opting for a tooth-shaped crown, 

it must intersect with the selected STL 

surface. In contrast, if you select a 

unclosed crown, it doesn't necessarily 

need to intersect with the STL. 
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Step 7 

Click the 'Preview' button to create a prototype of the future custom part for further editing. It will be visualized 

as Meridian slices, divided into three parts:  

 Apical  

 Base  

 Bend.  

 

 Each part forms the corresponding contour with specific color-coded points. The Apical contour follows the 

crown surface, while the Base and Bend contour points are positioned in intermediate locations between the 

Apical contour and the boundary line. 

 

 

Step 8 

 

Edit contours of the prototype of the model 

by moving and changing the curvature of 

the contours. 

The Apical, Base, or Bend contour can be 

moved in two ways: by adjusting individual 

points or by modifying the entire contour 

as a whole. 

 Apical Individual contour adjustment: To 

change the contour individually, move 

individual points using the left mouse 

button in the rendering window or in 

rotating slice window (1). 

 Contour adjustment as a whole: Use the 

respective control in the control panel to 

modify the entire contour (5, 6). 

 Changing the curvature of the Base and 

Bend contours can also be done both 

collectively and individually. 

  Perform individual editing of the curvature 

of Base and Bend contours in the rendering 

window by scrolling the mouse while 

holding the right mouse button or by 

dragging  

points with the left mouse button pressed in 

the rotation slice window (2, 3). 

  Group editing of Base and Bend contour 

curvature: You can collectively edit the 

curvature of Base and Bend contours using 

the corresponding "Base Deform" and "Bend Deform" controls on the control panel (7). 

 

Use the specified buttons on the control panel to toggle specific elements on or off, such as: 

 Apical, Base, or Bend contours 

 Crown/Abutment  

 Result (the intermediate model result before project export)  

 Intersection line (the line where the crown intersects with the STL surface)  

 Hole diameter (the screw head shaft)  

 

 

Hint 

It is recommended to edit the Apical contour 

first and then the Base and Bend contours to 

avoid losing the editing results of the latter 

when attempting to edit the Apical contour. 

Hint 
To determine the part of the edit you're 

working on, pay attention to the size of the 

dots. They will be larger in the active slide. 
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Step 9 

Set: 

 the diameter value of the screw head shaft In the Hole Diameter digital window.  

 The Base Gap size to determines the gap size between the cylindrical portion of the superstructure's base 

and the crown  

 

 

 

Step 10 

Adjust the Smooth connection by scrolling the mouse wheel or 

clicking and dragging the slider on the control panel, and set 

the Smooth radius value  

The Smooth Connection button is used to smoothen the 

transition between the apical and coronal surfaces. 

 

 

 

Step 11 

Enable the 'Remove Undercut' option to eliminate any undercuts found in the cylindrical section of the 

superstructure. 

 

 

 

Step 12 

Activate the 'Cut with Cylinder/Cut with Cylinder 2' buttons to 

create and cut additional objects of different shapes, which will 

be subtracted from the crown in the final step  . Adjust the 

desired parameters by either filling in the digital windows or 

using the scroll. 

 

 

 

 

 

 

 

Step 13 

Complete the modeling creation by clicking 

the 'Make' button to finalize the model 

creation.  

 

 

 

 

Step 14 

Click the 'Move to the Project' button to transfer the model file to the project. 

 

Hint 
After creating the model, it is possible to make 

additional modifications; use the 'Make' button 

again to refresh the results. 
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11.3 Custom Healing Abutment Modeling 

 

 
 

 

 

 

  

1 Based on 

2 Base Contour 

3 Number of slices 

4 Preview button 

5 Coronal contour slider  

6 Apical contour slider 

7 Base & Bend contour sliders 

8 Base & Bend deform sliders 

9 Abutment/Crown visualisation button 

10 Result  visualisation button 

11 Intersection line  visualisation button 

12 Center Height Slider 

13 Hole Diameter setting 

14 Base Gap setting 

15 Smooth Connection button 

16 Make button 

17 Remove Undercut checkbox 

18 Cut with Cylinder  buttons 
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Step 1 

 Choose the necessary elements: 

  relevant STL surface. 

 implant. 

 suprastructure to be used in conjunction with the 

chosen implant. 

 crown or tooth. 

 

 

 

Step 2 

Click the 'Custom Provisional Crown' button in the Modeling section. 

 

 

Step 3 

Begin by selecting the location where the provisional crown will be based, either at the Abutment or Implant 

levels. 

 

 

 

Step 4 

Choose the Base Contour using the necessary instrument for shaping the border: Edge, Line, or Auto. 

 The 'Edge' tool: The Base Contour will be automatically generated based on the nearest surface edge to the 

set point. To set the point, left-click at the desired location, and the base contour will be created. It will be 

displayed as a red line. Double-click the left mouse button to lock the line. 

 The 'Line' tool: This tool allows manual drawing of the base contour, which will also appear as a red line. Set 

contour points by left-clicking at the necessary positions in the rendering window. Right-click can be used to 

delete points. Complete the contour drawing by double-clicking the left mouse button. 

 The 'Auto' tool is designed for the automatic placement of the base contour at any specified point location. 

To set the point, left-click at the necessary location and double-click to lock the base contour. 

 

 

Step 5 

To adjust the contour, check the 'Edit' checkbox. The line will 

be represented by a set of points that can be moved using 

the left mouse button or deleted using the right mouse 

button. The density of points on the line can be changed in 

the digital window. 

 

 

 

Step 6 

Choose the Number of slices by selecting one of the available positions. Slices represent meridian segments 

used for editing individual parts. The default value is 12. Increasing this value allows for more precise editing. 

 

 

 

 

 

Note! 

When opting for a tooth-shaped crown, it 

must intersect with the selected STL 

surface. In contrast, if you select a 

unclosed crown, it doesn't necessarily 

need to intersect with the STL. 
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Step 7 

Click the 'Preview' button to create a prototype of the future custom part for further editing. This prototype 

consists of meridian slices, divided into four parts:  

 Coronal  

 Apical  

 Base  

 Bend  

Each part corresponds to a specific contour with colored reference points. 

The coronal contour, similar to the apical contour, moves along the crown surface 

 

 

 

Step 8 

 

Edit contours of the prototype of the 

model by moving and changing the 

curvature of the contours. 

 The Coronal, Apical, Base, or Bend 

contours can be modified in two ways: by 

adjusting individual points or by modifying 

the entire contour collectively. 

1. Coronal and Apical Individual Contour 

Adjustment: 

To individually change the contour, move 

individual points using the left mouse 

button in the rendering window or the 

rotating slice window (1,2). 

2. Contour Adjustment as a Whole: 

You can modify the entire contour by using 

the respective controls in the control panel 

(5,6,7). 

 Changing the curvature of the Base 

and Bend contours can also be performed 

both collectively and individually. 

Individual Editing of Base and Bend Contours 

Curvature: This can be done by scrolling the 

mouse while holding the right mouse button 

(3,4). 

Group Editing of Base and Bend Contours 

Curvature: Group editing is possible using the 

corresponding "Base Deform" and "Bend 

Deform" controls on the control panel or by dragging points with the left mouse button pressed in the rotation 

slice window. 

 

Use the specified buttons on the control panel to toggle specific elements on or off, such as: 

 Coronal, Apical, Base, or Bend contours 

 Crown/Abutment  

 Result (the intermediate model result before project export)  

 Intersection line (the line where the crown intersects with the STL surface) (4) 

 Hole diameter (the screw head shaft) (5) 

 

Hint 

It is recommended to edit the Apical contour 

first and then the Base and Bend contours to 

avoid losing the editing results of the latter when 

attempting to edit the Apical contour. 

Hint 
To determine the part of the edit you're working 

on, pay attention to the size of the dots. They 

will be larger in the active slide. 
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Step 9 

Set:: 

  diameter value of the screw head shaft In the Hole Diameter digital window  

 The Base Gap size to determine the gap size between the cylindrical portion of the superstructure's base 

and the crown 

 

 

 

Step 10 

 

Adjust the Smooth connection  by scrolling the mouse wheel 

or clicking and dragging the slider on the control panel, and 

set the Smooth radius value. 

The Smooth Connection button is used to smoothen the 

transition between the apical and coronal surfaces.). 

 

 

Step 11 

Enable the 'Remove Undercut' option to eliminate any undercuts found in the cylindrical section of the 

superstructure. 

 

 

Step 12 

Activate the 'Cut with Cylinder/Cut with Cylinder 2' buttons 

to create and cut additional objects of different shapes, 

which will be subtracted from the crown in the final step  . 

Adjust the desired parameters by either filling in the digital 

windows or using the scroll. 

 

 

 

 

 

 

 

Step 13 

Complete the modeling creation by clicking the 'Make' button 

to finalize the model creation. 

 

 

 

 

 

 

Step 14 

Click the 'Move to the Project' button to transfer the model file to the project. 

 

 

 

Hint 

After creating the model, it is 

possible to make additional 

modifications; use the 'Make' 

button again to refresh the 

results. 
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There are no chemical, physical, electrical, mechanical, electromagnetic and biological hazards to the INNO 

PLAN software.  

However, there are several warning functions designed to remind the user of his legal responsibility to verify 

implant planning stages and results. 

 

 

INDICATIONS FOR USE 
 

Warning! 
The INNO PLAN software must be used in accordance with their accompanying instruction for 

use 

 

Warning! This device is not tested on the pediatric patient population 

 

Warning! 

Prior to working with software, please make sure to have received appropriate training and 

instructions in software operation. Cowellmedi offers regular online webinars for INNO PLAN 

which is open for all users 

 

Warning! Correct design of the surgical guide lie within the sole responsibility of the user 

 

Warning! 
3D manufacturing is out of INNO PLAN software control, depends on many external factors and 

lie within the sole responsibility of the user 

 

Warning! 

The manufactured surgical guides for implant placement are classified as medical devices by the 

FDA (under 21 CFR 872.3980). Surgical guides are subject to legal requirements such as 

registration and listing as a manufacturer of medical devices, validation of production 

equipment, processes and quality system regulations 

 

Warning! 
In the US. 3D printed surgical guide is a medical device to be manufactured at an FDA registered 

and listed manufacturing location 

 

DICOM 

 
 

Warning! 
The user is solely responsible to ensure that the quality of the loaded patient CT/CBCT data is 

sufficient for proper planning the case 

 

Warning! 
The production of CT/CBCT scans lies within the full responsibility of the clinicians or 

appropriately qualified personnel. The CT/CBCT scanner should be maintained within original 

manufacturer specifications 
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NERVE CANAL 
 

Warning! 
Make sure that the nerve is correctly traced.  Always maintain an appropriate safety distance to 

the nerve canal 

 

Warning! 

The pathway of imaged nerves is for display only, location accuracy of the traced nerve is not 

tested, and pathways of imaged nerves can not be used as sole information for the clinician to 

make clinical decisions 

 

IMPLANT PLACEMENT 
 

Warning! 

During implant placement, please assure that an implant/pin does not collide with an existing 

implant/pin, tooth root(s) or nerve canal. A collision of the implant/pin with another implant, 

nerve, or any other main anatomical structure can cause severe damage 

 

Warning! 

The user must be able to recognize the triangular sign "Attention" to detect warnings such as 

“Collision between implant/pin and implant/pin”, "Collision between sleeve and scan STL 

surface", and "Collision between implant/pin and nerve canal" 

 

Warning! 
Using the STL files of implant and other elements libraries created by reverse engineering are 

made at the user's risk 

 

SURGICAL GUIDE 
 

Warning! 
Make sure that created STL file of the surgical guide or produced surgical guide is intended to 

be used only by trained qualified dental practitioners 

 

ALIGNMENT 
 

Warning! 
Make sure that CBCT/CT and STL surface scans are well aligned in all relevant areas, particularly 

in the implant placement area 
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How to evaluate the quality and accuracy of alignment? 
 

 

The software enables users to overlay and align DICOM visualization to the STL surface by picking points on 

both surfaces as a landmark (see part 6, p.28). 

There is a tool to correct an alignment manually in MPR or Panoramic mode. Dragging the scan with the square 

point (A) or rotating the scan using the control point on contour line (B) of the scan provides your movement to 

one dimension in Axial, Coronal, and Sagittal views (see picture). 

 

The aim is to get the contour of the STL surface scan to coincide with the corresponding object on the CT scan. 

Teeth are a good landmark for alignment.  
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Examples of the alignment results: 
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Dual Scan Technique 
 

 

Full Digital Workflow for the Treatment Planning of an Edentulous Patient with Guided Surgery using Dual 

CBCT/CT Scanning Technique.  

 

Hint 

Definitions: 

Dual Scan Technique (DST). The dual scan (dual CBCT scanning technique) is the term used when a 

dental appliance, such as a set of dentures, is superimposed over the patient CBCT/CT scan. 

 

Scan Appliance is a denture with temporary radiopaque markers that are applied directly to the inside 

and outside of the denture. 

 

DST Patient CBCT/CT Scan is a head CBCT/CT scan of the patient wearing the denture prepared with 

temporary radiopaque markers. The patient’s dentures should be in occlusion when the scan is taken. 

 

 

INNO PLAN DUAL SCAN TECHNIQUE WORKFLOW: 
 

 

Step 1 

Import an existing project (see section 4.6.2 - Tool Panel) or create a new project. 

 

 

 

Step 2 

Import Patient’s CBCT/CT scan data: 

Click the New Project / Load DICOM button to upload the patient’s DICOM data 

(see Chapter 5. Input Data (DICOM)). 

 

 

 

Step 3 

Import Scan Appliance DICOM data:  

Click the STL Surfaces button in the tab panel on the right 

part of the screen. 

 

Click on  button and select the Scan Appliance 

DICOM file on your computer.  

Press “OPEN” and wait for it to finish loading. 

 

 

 

  

Note! 

To use the Dual Scan Technique, you 

need to import DICOM data of the 

Scan Appliance(s) with radiopaque 

markers. 
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Step 4 

Convert the dental appliance to STL 

Converted STL is shown in STL list and named 

“Converted from DICOM”.  

 

 

 

Step 5 

Align converted STL: 

Click Align button on STL workflow panel.  

Place points on the radiopaque markers scan in the left 3D pane and corresponding points on the Surface Scan 

in the right 3D pane. Then click the "Align Surface to selected object" button. 

 

  

Hint 

To convert Dental Appliance scan 

data, follow the instruction described 

in Chapter 5.2 “DICOM to STL 

Conversion” of this User Manual. 
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CREATE A SOFT TISSUE SURFACE (SPLIT AND INVERT) 

Once the CBCT/CT scans are aligned, you can proceed to the soft tissue surface detection step.  

 

Step 1 

Open the STL tab and choose necessary STL.  

 

 

Step 2 

Click the “Edit” button, then open the “SELECT” tool.  

 

 

Step 3 

Click "Line" then click “Dotted” or “Projected”. 

Set up the 3D object position, draw the borderline by placing points one after another around the area of 

interest.  

 

 

Step 4 

Click “Split” to split an object into two objects with open boundaries along the selection line.  

 

 

Step 5 

Then invert the object you want to use as a guide planning surface (see Annex G – 1.1.4 Invert). 

 

 

 

 

 

  



. 

87 

 

PERFORM IMPLANT PLANNING 
 

Once the soft tissue surface is created, you can proceed to 

the Implant planning, follow the instruction described in 

Chapter 9 – “IMPLANT PLANNING” of this User Manual. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 CREATE THE SURGICAL GUIDE 

Follow the instruction described in Chapter 11. SURGICAL GUIDE CREATION. 

 

 

 

 

 

 

 

 

 

 

 

CREATE THE SURGICAL GUIDE BASED ON 

PROSTHESIS 

 

Optionally you can proceed to the surgical guide creation 

exactly after the CBCT/CT scans alignment step. (see Section 

11.1 Surgical Guide Based on Prosthesis). 
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How to anonymize your project file 
 

 

Step 1 

 Click the "Save" button located on tool panel. 

 

 

Step 2 

Under the "Save File" submenu, decide on your save location. 

 

 

Step 3 

 In the "File Name" field, type in 

your preferred Project file name (do 

not use patient name in project file 

name).  

 

Click "Save" to save your file. 

 

 

 

 

 

 

 

 

 

 

Step 4 

Under the next "Save Project" 

submenu, click "Anonymize Project" 

(A) . 

Click "OK" (B). 
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Cloud Service 
 

 

Click the “Cloud Service” button in tool panel.  

 

TABS 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1 
"Received" tab. Double-click a received project file to open the 

project or select received project file 

2 
"Sent" tab. Click a “sent” project file to open the project, you 

sent before. 

3 
"Private" tab. Click an “Anonymous” project file to open the 

anonymous project. 

4 

"Basket" tab.  Deleting project files from your inbox doesn't 

permanently delete them immediately - they'll move to the 

"Basket" folder where they'll remain for 90 days before being 

deleted automatically. 
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BUTTONS 

 

 

Refresh 

 

Open project 

 

Forward project file 

 

Delete file 

 

Restore deleted file 

 

Contacts 

 

Add new contact 
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 HOW TO SEND A CASE 

 

Step 1 

Click  on tool panel. Doing 

so prompts a "Contact List" window. 

 

 

 

 

 

 

 

 

 

 

 

Step 2 

Enter/select your recipient's email address. In 

the "Add Contacts" text box, type in the email 

address or select the existing recipient's email 

in the list. 
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 HOW TO SAVE IN THE CLOUD 

 

Saving your Project File in the cloud lets 

you access them from anywhere.  

 

To save Project File online with 

Cowellmedi Cloud, click  

make a brief description of the case and 

click OK. 

 

 

 

Warning! 

Cowellmedi Inc. uses AWS's utility-based cloud services to process, store, and transmit encrypted 

Project Files. 

AWS's utility-based cloud services stores data (Project File) for at least one year after data 

generation completes. Cowellmedi will send user an alert email one month before removing data 

from the server. 
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Cybersecurity Hygiene 
 

 

The INNO PLAN software does not store patient personal data, medical information, PII and non-PII data 

directly. All the data is stored on the user PC. User is responsible for data protection on the user side. 

 

To protect data against loss or unauthorized use, several security mechanisms have been implemented in INNO 

PLAN: 

Restrict user access to the storage media, operating system by setting up a strong user password; 

Create a unified way of working. Installation / Upgrade of product security patches and software packages by an 

authorized user and/or possibly authorized HDO or Dental Lab staff. 

Configure the operating system to prevent further access to the system by initiating a session lock after 10 min 

of inactivity or upon receiving a request from a user; 

Configure the operating system to restrict the access to security features of the PC; 

Use data encryption to secure Patient data, Project Files, Drilling protocols on your computer system and 

storage media; 

Use the anonymization function to protect patient personal data if required; 

Backup your data regularly and always backup before updating or uninstalling the software; 

Use anti-virus software, firewall. 

. 
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Implant Libraries for INNO PLAN 
 

 

INNO PLAN supports COWELLMEDI IMPLANT libraries that let customers precisely plan the implantation. 
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STL Editor 
 

 

STL EDITOR (FUNCTIONAL) 
 

The Edit tools within The INNO PLAN software is a comprehensive feature that helps to effectively modify STL 

surfaces. It grants access to a diverse array of powerful tools and functions, enabling efficient manipulation of 

STL geometry. 

 

Step 1 

Click the “STL” button on the 

Tab panel (1). 

  

 

Step 2 

Pick the necessary STL object 

from the list of available STL 

(2). The selected object will be 

highlighted in the list.  

 

 

Step 3 

Left-clicking on the “Edit” 

button (3) beneath the list will 

initiate editing. After clicking 

the Edit button, the editing 

toolbar will open (5). 

Once the Edit button is 

clicked, the INNO PLAN will 

create a duplicate STL object 

with the same colour (4).  

 

  

Hint 
All changes made during editing will be applied to this copy, and it is always possible to revert to 

the original object. 
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FIX TOOL PANEL 

 

Step 1 

Click “Fix” (1) to open the tool panel. 

 

 

Step 2 

Choose necessary instrument: 

 

 

 

 

 

 

 

 Fill Holes 

Use "Fill Holes" to fill all holes 

in the surface mesh and 

remove all small unrelated to 

the main object parts.  

 

 

 

 

 

 

 

 

OR 

 

 

 Fix Structure 

The STL file errors could be 

intersections between 

triangles and non-manifold 

edges. 

Use "Fix Structure" to fix the 

intersections between 

triangles, and non-manifold 

edges. 

This tool as well removes all 

small unrelated to the main 

object parts 
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OR 

 

 

 Close Mesh 

To close an open boundaries 

use "Close Mesh" and the 

software will make a new face. 

Non-closed mesh is detected 

if some edges of the STL file 

are not connected to only 

one face, this essentially 

means that the model has a 

hole and does not represent 

a closed surface. 

 

 

 

 

OR 

 

 

 

 

 Invert 

Use "Invert" to reverse the 

orientation of all triangles on 

a surface. 

This tool flips any triangles 

with inverted normals on a 

surface. This is helpful if an 

entire portion of the model 

has inverted normals. 

 

 

 

 

 

  

Hint 
This tool is more often used when creating a surface from a prosthesis file obtained using the double 

scan technique. 
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OR 

 

 Flatten 

There are thin areas on an 

STL that has actual errors in 

its mesh that are hard or 

impossible to fix using "Fix 

Structure" or "Smooth" tools. 

Point the cursor (brush) at 

the error area on the mesh. 

Change the brush size with 

the mouse wheel. 

Click the left mouse button to 

blend the improved area 

completely into the model.  

 

 

 

 

OR 

 

 

 Add Bridge 

In case, there is a need to 

manually connect the gap 

(hole) at the surface, the 

"Add Bridge" tool comes in. 

 

Use "Add Bridge" and gap 

(hole) boundaries will be 

automatically highlighted 

and visualized in the 3D 

Rendering Window.  

Point the cursor and click 

the left mouse button at the 

open boundaries of the 

hole. 

 

Click a position at the 

desired open boundaries to manually add bridging triangles.  

Repeat the "Add Bridge" feature for a few areas around  the perimeter of the gap (hole), and then use the "Fill 

Holes" tool to fill the remaining holes.  

 

 

OR 

Hint This action includes selecting, deleting and closing selected open boundaries. 

Hint 
A good error prevention practice is to use the "Fix Structure" tool before repairs in order to increase and 

homogenize the triangulation in the area concerned. 
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 Add Edge 

This tool is very similar to the 

“Bridge” tool, with the only 

difference being that it works 

with open edges. 

 

Point the cursor and click the 

left mouse button at the 

open edge of the surface  

Click a position at the desired 

open edge to manually add 

triangles and make a new 

face. 

 

 

 

 

 

OR 

 

 

 Close Hole 

This tool is very similar to the 

“Fill Holes” tool, with the only 

difference you can choose 

which hole to close. 

 

Use "Close Hole". Gap (hole) 

boundaries will be 

automatically highlighted 

and visualized in the 3D 

Rendering Window.  

Point the cursor at the 

highlighted boundaries of 

the hole and double-click on 

it to close the mesh. 

 

 

 

 

 

 

OR 

Hint 
A good error prevention practice is to use the "Fix Structure" and “Fill Holes” tools before repairs in 

order to increase and homogenize the triangulation in the area concerned.  

Note! If a triangle edge does not have a valid neighbour, that edge will be highlighted to indicate a problem. 
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 Flex Fill 

 

Point the cursor at the highlighted 

boundaries of the hole and double-

click on it.  

 

Then the software should create a 

blue-colored patch, and you can 

change the curvature of the patch by 

scrolling the mouse wheel, making 

surface concave or convex.. To close 

the mesh, just double-click on the 

patch again.  

 

 

 

 

 

 

 

 

 

 

 

 

  



. 

101 

 

 CUT TOOL PANEL 

 

The segment of the object can be cut and split in different ways. You 

can select segment using Box, Line, Circle, Square, and Abutment 

Cylinders tools.  

 

Step 1 

Click “Cut” (1) to open the tool panel. 

 

 

Step 2 

Choose cutting tool: 

 

 

 

 

 

 Box 

Set up the box position by choosing the next options:  

"Below the Axial", 

OR  

"In the Center",  

OR 

"Above the Axial" to move the 

box along the X-axis. 

 

Adjust the box size. The 

connection between the box 

and coordinate axes allows 

adjusting the orientation of 

the cutting plane either in 2D 

windows by dragging the 

center of the intersection of 

the axes with the left mouse 

button or in a 3D window by using the red arrows to rotate and adjust the cutting box.  

 

ОR 

 

 Line 

Point a freeform shape around 

the area you want to select 

with Left Mouse Button.  
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OR 

 

 Circle 

Drag a circle shape to the 

area you want to select with 

Left Mouse Button. Adjust the 

circle size with Scroll Wheel.  

Optionally you can now either 

click arrows up and down or 

double-click the number and 

input a specific number 

adjusting the size of the shape. 

  

 

 

 

OR 

 

 Square 

Drag a Square shape to the area 

you want to select with Left 

Mouse Button. Adjust the square 

size with Scroll Wheel.  

Optionally you can now either 

click arrows up and down or 

double-click the number and 

input a specific number 

adjusting the size of the shape. 

 

 

 

 

OR 

 

 

 Abutment Cylinder 

The Abutment Cylinder cutting 

tool can be used to create 

circular holes along the axes of 

the abutments. 

 

Click "Abutment Cylinder" to 

visualize the axes of the implant 

abutments in the 3D rendering 

window.  

 

Adjust the diameter and 

position of all cylinders.  

Optionally set up each cylinder 
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separately - move the cursor to the desired axis and change the diameter by scrolling the Mouse Wheel.  

 

Adjust the position of the bottom of the cylinders in the Cut tool panel. 

 

Step 3 

Click either  

“Cut Inside” to cut a selected segment into the box,  

OR 

“Cut Outside” to cut an unselected segment of the surface,  

OR  

“Cut in Two” to split the surface. 

 

The “Cut all on the screen” checkbox applies the cutting shape to all visible objects on the screen. 
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SELECT TOOL PANEL 

 

In the “Select” section, INNO PLAN offers several tools that can be 

applied directly to the mesh to select the desired area. 

 

Step 1 

 

Click “Select” to open the tool panel. 

 

 

Step 2 

Choose necessary instrument: 

 

 

 

 Box 

Set up the box position by choosing the next options:  

"Below the Axial",  

OR  

"In the Center",  

OR 

 "Above the Axial" to move the box 

along the X-axis. 

Adjust the box size. The connection 

between the box and coordinate 

axes allows adjusting the orientation 

of the selecting plane in 2D windows 

by dragging the center of the 

intersection of the axes with the left 

mouse button. The red arrows are 

used to adjust and rotate the box in 

a 3D window.  

 

 

OR 

 Brush 

The Brush tool can be used to select 

an area on the STL surface. 

To adjust the diameter of the Brush 

tool, simply scroll the mouse wheel.  

To use the tool, move the cursor in 

the 3D rendering window, click and 

hold down the left mouse button 

while moving the brush to select the 

desired area. To remove the 

selection click and hold down the 

right mouse button while moving 

the brush. 
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OR 

 

 

 Line. Dotted/Projected. 

Click "Line" then click “Dotted” or 

“Projected”. 

Point the cursor at the desired area 

on the mesh and click the left mouse 

button to place the first point, and 

then draw a line by dragging the 

mouse and clicking to place more 

points.  

Double-click to close the line.  

Select the Edit mode to adjust the 

shape of the outline, move the cursor 

over the line and use the available 

control points. 

 

 

In Projected mode - the line is 

projected onto the STL surface 

perpendicular to the screen immediately at the moment of point positioning. For acceptable line drawing, 

ensure that the surface is parallel to the screen when the point is positioned. The next point is not set if the 

previous one,  

due to the rotation of the STL, becomes invisible.  

 

 

OR 

 

 

 

 Line. Lasso 

The Lasso tool is a freehand selection 

tool, it won’t try to predict what you 

want to select. 

Click "Line", then click “Lasso”. 

Point the cursor at the desired area 

on the mesh and click, hold the left 

mouse and drag to outline the shape 

of your selection on the STL surface. 

Select the Edit mode to adjust the 

shape of the outline, move the 

cursor over the line and use the 

available control points. 

Or move a mouse cursor over the 

line and draw an additional line 

outside or inside the contour to 

redraw and adjust the shape of the 

outline.  
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OR 

 

 Line. Adaptive 

This tool is very similar to the “Dotted” 

tool, with the only difference being that 

the software adapts the line to the 

edges of the triangles. 

Click "Line" then click “Adaptive”. 

Point the cursor at the desired area on 

the mesh and click the left mouse 

button to place the first point, and then 

draw a line by dragging the mouse and 

clicking to place more points.  

 

Double-click to close the line.  

Select the Edit mode. Now you can 

move the cursor over the line and use the available control points to adjust the shape of the outline.  

 

 

OR 

 Line. Edge 

The Edge tool is an automated 

selection tool, which means it would 

automatically snap to the edge of 

objects and try to predict what you 

want to select. INNO PLAN will help 

complete your shape by connecting 

small gaps between your starting 

point and endpoint. 

Click "Line" then click “Edge”. 

Point the cursor at the desired edge 

on the mesh and click the left mouse 

button to place the first point, and 

the software automatically complete 

the shape.  

Double-click to close the line.  

Select the Edit mode. Now you can move the cursor over the line and 

use the available control points to adjust the shape of the outline.  

 

 

Step 3 

 

After finishing the selection, the next options are available:  

 

- invert selected area  > 

 

- cancel the selection  > 

 

 

 



. 

107 

 

Step 4 

Select. Delete 

 

Click “Delete” to cut off a selected segment of a surface into the selected area. 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

OR 

 

 

 

Select. Split 

 

Click “Split” to split an object into two 

objects with open boundaries along the 

selection line. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hint 
This tool is more often used when creating a surface from a prosthesis file obtained using the 

double scan technique. 
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SMOOTH 

 

The Smooth brush matches the selected area to the curvature of the surrounding area and makes it smooth. 

 

Step 1 

Click “Smooth” in the Edit menu. 

 

 

 

Step 2 

Set  

“Average Size” to get the average size of the triangle at the smoothed 

surface. Adjust the size yourself by entering numerical values in the 

corresponding window. 

  

 “Strength” to increase or decrease the smoothing intensity. 

 

 

 

 

Step 3 

 

Point the cursor and click or click 

and hold the left mouse button on 

the area you want to smooth. 

OR  

Click to "Smooth all" to remesh, 

optimize triangle count and 

smooth the whole surface of the 

object. 
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DEFORM TOOL PANEL  

 
Use this function if you want to change the mesh curvature locally. 

Step 1 

 

Click "Deform" in the Edit menu. 

  

 

 

Step 2 

Choose one of deform tool: 

 

 

 

 

 

Brush 

 

Set “Average Size” to get the average size of the triangle of the 

surface. Adjust the size of brush by entering numerical values 

in the corresponding window or adjust the brush size with 

scroll wheel. 

Use the “Strength” slider to increase or decrease the smoothing 

intensity.  

 

 

 

OR 

 

 

Spheres 

The sphere is a very specific brush. The center of the Sphere is 

always on the surface of the mesh.  

Adjust the size of sphere by entering numerical values in the 

corresponding window or adjust the sphere size with scroll 

wheel. 

 

 

 

 

 

 

Step 3 

Point the cursor at the desired area, click and hold the left mouse button on the area making it convex, or click 

and hold the right mouse button on the area making it concave. 
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REMESH 

 

Split triangles – is an edge split and 

it would insert a new vertex which 

decreases the length of the original 

long edge if it’s longer than high. 

The key aim for the Isotropic 

remeshing is to set all the triangle 

edge lengths to be the same and all 

the vertices have perfect valence. 

The main benefit of this feature is 

the simplification of subsequent 

model editing. 

 

 

 

Step 1 

Click "Remesh" in the Edit tab. 

 

 

Step 2 

Click “Average Size” to get the average size of the triangle of the surface. 

Adjust the size of triangles by entering numerical values in the 

corresponding window. 

 

 

Step 3 

 Click  

“Spit Triangles”  

or  

“Isotropic” to start remeshing. 

 

 

 

 

Step 4 

  

If there is a need for local remeshing, point 

the cursor and click and hold the left 

mouse button on the area you want to 

remesh. 

 

Adjust the brush size with scroll wheel. 
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Remesh: Simplify 

 

The more triangles in a scanned or converted STL model, the smoother the 

shapes of the surface will be, but also the larger the file size, the longer the 

editing time. Conversely, fewer triangles in an STL model means it will fix 

and edit faster. 

 

Step 1 

Click "Simplify" to reduce the number of triangles.  

 

 

Step 2 

You can now either click arrows up and down or double-click the number 

and input a specific number. 

 

 

 

  

 

 

 

                                 

 

 

 

 

 

 
 

 

 

Note! 

 

Look what happens when you drop the triangle number down from 203953 to 50000.  You can 

still make out the basic shape of the STL object, but its smooth curves have been lost underneath 

a sharply-faceted surface. 
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BOOLEAN OPERATIONS 

In STL Editing, by Boolean operations, we mean creating 

intersections and unions of objects, as well as subtracting objects 

from each other. 

In INNO PLAN next Boolean operations are available: 

 

 

 

Unite 

 

Unite is a complex algorithm that merges two objects into a single 

mesh. 

 

Click "Boolean" in the Edit menu. 

Choose “Unite” in Boolean Tool 

Tab.  

And then either click directly on 

the object you want to attach in 

the 3D visualization window, or 

on the object in the list of the STL 

files. 

 

 

 

 

 

 

 

 

 

Intersect 

 

The "Intersect" tool creates an 

STL object from the intersection 

area between two STL objects  

Click "Boolean" in the Edit tab. 

Choose “Intersect” in Boolean 

submenu. And then either click 

directly on the object you want to 

intersect in the 3D visualization 

window, or on the object in the 

list of the STL files. 
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Subtract 

 

The subtraction occurs between 

two objects - the chosen object is 

subtracted from the main initial 

object.  

Click "Boolean" in the Edit tab. 

Choose “Subtract” in Boolean 

submenu. And then either click 

directly on the object you want to 

subtract in the 3D visualization 

window, or on the object in the list 

of the STL files. 

 

 

 

 

Cut inside/Cut outside 

 

The cutting tool is used to cut the 

surfaces of STL objects, resulting in 

an opened STL surface. 

Click "Boolean" in the Edit tab. 

Choose “Cut Inside” or “Cut 

Outside” in Boolean Tool Tab.  

And then either click directly on 

the object you want to attach in 

the 3D visualization window, or on 

the object in the list of the STL files. 

 

 

 

Connect 

 

This tool is very similar to the 

“Unite” tool, with the only 

difference being that it connects 

only the major part of the chosen 

object (yellow), all intersection and 

minor parts would disappear. 

Click "Boolean" in the Edit tab. 

Choose “Connect” in Boolean Tool 

Tab.  

And then either click directly on the 

object you want to connect in the 

3D visualization window, or on the 

object in the list of the STL files. 
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BAR 

 

Step 1 

Click "Bar" in the Edit tab. 

 

 

 

Step 2 

Set: 

 Type of Bar 

Straight 

OR 

Curved 

 Adjust the Diameter of bars by entering numerical values in 

the corresponding window. 

Choose one option of constructing a bar:  

 

CONNECT option is used to construct a bar when it does not fully 

intersect one or more intermediate parts of the object in its middle 

section. This option is also suitable for building a support bar when 

one or both parts of the object have thin walls. 

OR 

INTERSECT option is used when constructing a bar in a way that its middle section fully intersects one or more 

intermediate parts of the object. 

 

 

 

Step 3 

Point the cursor at the desired area, 

click the left mouse button and 

when you will move your mouse 

away from this point, a purple solid 

bar will be displayed between the 

initial point and the mouse cursor 

position, then click the left mouse 

button again and the software will 

set the bar. 

 

 

 

Step 4 

Now you can change the shape and 

diameter of the bar by dragging 

active points and scrolling the mouse wheel. 

 

 

 

Step 5 

Click Apply. 
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LABEL 

 

Step 1 

Click "Label" in the Edit tab. 

 

 

Step 2 

Type the desired text into the text field (1). 

 

 

Step 3 

Set: 

 label design:  

concave  

 

OR  

 

convex (2). 

 

 label depth. 

 

 

Step 4 

Move the text to the desired position on the STL surface and click on it to set the label position.  

 

 

Step 5 

Click on Apply. 

 

  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

  

Hint Delete a label by right-clicking on it. 
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EXTRA 

Offset 

 

The "Offset" tool expands or contracts a selected STL object by a 

specified amount of millimeters. 

 

Step 1 

Click "Extra" in the Edit menu.. 

 

 

Step 2 

Set the numerical values in the corresponding window. 

 

 

Step 3 

 Click “Offset”.  
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Extrusion 

 

The “Extrusion” tool extrudes selected surface locally. 

 

Step 1 

Select desired area on the STL surface using the “Select” submenu.  

 

 

Step 2 

Click "Extra" in the Edit menu.  

 

 

Step 3 

Set the numerical values in the corresponding window. 

 

 

Step 4 

 

 Click either 

 

 

    The software creates the extrusion 

outside of the initial surface 

          

OR 

 

The software creates the extrusion 

inside of the initial surface 

 

OR 

 

 The software creates the extrusion in 

the middle of the initial surface 

 

 

The new object will be appeared in STL list. 
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Mirror 

The "Mirror" tool creates a mirrored duplicate of a selected object. 

 

Step 1 

Click "Extra" in the Edit menu then click “Mirror” to mirror the object 

along the axial, coronal, or sagittal axis. 

 

 

Step 2 

Choose one of plane you want to mirror relative to: 

 

 

 

 

 

 

 

 

 

The axial (or transverse plane) is a horizontal plane dividing the object 

into superior (upper) and inferior (lower) sections. 

 

 

 

 OR 

 

 

 

The coronal plane is a longitudinal plane, dividing the object into 

anterior (front) and posterior (back) sections. 

 

 

 

 

OR 

 

 

 

The sagittal plane refers to a vertical plane that divides an object into two 

parts: the right and left sections.  
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Cylinders 

 

The “Cylinders” tool creates a single cylinder or a group of cylinders 

located perpendicular to the surface plane. 

 

 

Step 1 

Click "Extra" in the Edit menu.  

 

 

Step 2 

Click "Cylinder" and set up the settings: 

 Distance between the cylinder centers (mm),  

 Diameter of the cylinder (mm),  

 Top height of the cylinder above the STL surface (mm),  

 Bottom height of the cylinder below the STL surface (mm). 

 

 

Step 3 

In the 3D rendering window, point the cursor at the desired area and 

then click on the STL surface to create a cylinder. 

  

 

Step 4 

Click “Apply” and "Move to 

Project" and created cylinder/s 

will be transferred to the 

project as a separate object. 

 

 

 

 

 

 

 

 

 

 

  

Hint 

To create a group of cylinders, use the "Select" tool to select the necessary area on the STL object. 

After, click “Extra” and select “Cylinders”. Set up the necessary cylinder parameters and click "Move to 

Project" to generate the group of cylinders. 
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Add Base 

 

This tool is designed to create digital models of patient scans. 

 

Step 1 

Click "Extra" in the Edit menu and Click "Add Base" to add a vertical 

base under the open STL surface.    

 

 

Step 2 

Set the necessary parameters: 

 “Grid” parameter is responsible for marking the triangles on the 

platform. The smaller this value, the smoother the surface of the 

base. 

 “Height” slider adjusts the height of the base. 

 

 

Step 3 

Click the “Update” button. 

 

 

 

 

 

 

. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

  

Note! 
The result mimics the traditional based plaster dental model in appearance and can be easily 3D 

printed. 
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Cord 

The "Cord" tool generates a round cord on the selected surface.  

 

Step 1 

Click "Extra" in the Edit menu and click "Cord". 

 

 

Step 2 

Set:  

 “Radius” adjusts the cord's radius (mm) 

 “Offset” adjusts the distance between the cord's center and the 

object's surface (mm). A positive value moves the cord outward, 

while a negative value moves it inward.  

 

 

Step 3 

Click “Add” to add cord and click “   ”   to delete cord.  

To create a closed cord, select “Loop”. 

 

 

Step 4 

Point the cursor at the desired area on the mesh and click the left mouse button to place the first point, and 

then draw a cord by dragging the mouse and clicking to place more points.  

You must put at least three dots to make cord visualized in a 3D rendering window.  

 

Step 5 

Choose one of the Cord tool. 

 

 

"Cut" to remove the part of the cord located inside the STL 

object. 

 

 

 

OR 

 

 

"Unite" to unite the cord with the STL object. 

 

 

OR  

 

 

"Subtract" to subtract the cord from the STL object. 
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Segmentation tools 
 

 

The Segmentation tools enable the creation and editing of textures based on CT data, followed by STL 

conversion, which imitates both hard and soft tissue models. All segmentation tools are aimed at editing the 

matrix (texture). 

Essential tools:  

- Group control of matrix elements depending on DICOM optical density. 

- Local control of matrix elements depending on DICOM optical density. 

- 2D and 3D tools for removal of inner and outer shells.  

 

SEMENTATION MENU 

 

  

1 Data structures 

2 Local Editing tools 

3 Auxiliary controls 

4 General Editing Tools 
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Step 1 

To initiate the process, click on the “Convert to Surface” button in the DICOM tab. 

 

 

 

Step 2 

Set the region of interest (ROI) (see section 5.3 DICOM to STL Conversion). 

 

 

 

Step 3 

Click the "Continue editing" button to open Segmentation Editor. 

 

 

 

Step 4 

Use general editing instruments 

Fill in the number of voxel layers to input field  and click on necessary button.  

 

 Open to reduce and subsequently add selected edge voxel layers by a specified number indicated in the digital 

window . 

 

OR 

 

 Close to involve adding and then reduce the selected edge voxel layers by a specified number indicated in the 

digital window. 

 

OR 

 

Dilation to  add the selected edge voxel layers by the number specified in the digital window. 

 

OR 

 

Erosion to reduce the selected voxel edge layers by the specified value in the digital window. 

 

OR 

 

Smooth to determine the level of surface smoothing applied to the STL texture during its conversion.  

 

 

 

 

 

  

Note! General Editing tools work when the texture is unlocked. 

Note! It`s recommended to star work with General tools first, and continue with Local editing tools 
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Step 5 

Use the local editing tools 

 

3D Brush  

The 3D Brush enables localized 

(by sphere) adjustments to the 

ROI threshold level. The cursor 

is presented as a circle 

(2D visualization of the sphere), 

and which diameter can be 

modified by scrolling while the 

right mouse button is held. 

Left-click to decrease the local 

threshold within the spherical 

area, and right-click to increase 

the threshold.  

 

 

OR 

 

 

 

2D Brush  

The 2D Brush allows for the local modification of 

texture within a flat circular area in MPR mode slices. 

The diameter adjustment functions in the same way 

as the 3D Brush tool. The texture fill cursor circle 

appears when the left mouse button is pressed. 

Actions performed within this circle modify or apply 

the texture accordingly. The texture within the circle 

is erased when the right mouse button is pressed.  

In "Smart" mode, pressing “Ctrl” button smoothly and 

gradually changes the texture within the specified 

cursor zone. 

 

 

OR 
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Lasso  

The Lasso tool provides a 

quick and accurate way to 

select textures and regions of 

interest, including any 

connected closed texture 

areas outside the captured 

region, ensuring that the 

desired areas are included in 

the selection. 

 

 

 

 

 

OR 

 

 

Growing  

The Growing mode allows the selection of a volume of voxels with a specific optical density indicated by a circle-

shaped cursor, and which diameter can be modified by scrolling while the right mouse button is held.  

The left click attaches voxels within the optical density range of the sphere's voxels to the sphere's volume using 

the bounding principle, marked in blue. The optical density level of the selected area is adjusted by scrolling + 

Shift, and the volume of the selected area is adjusted by scrolling + Ctrl (use it for unlocked texture). To lock the 

selected array left-click outside the ROI box. Right-click to reverse the process erases the selected voxels with 

similar editing capabilities. 

 

 

 

 

 

  

Note! Customize the segmentation using Auxiliary controls. 
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Step  6 

Complete the segmentation process using 

1 "Convert" button converting the edited texture to an STL surface. If there are multiple volumes in the texture 

list, the active texture will be converted. 

If the texture needs additional editing after conversion, the program applies additional editing and converts the 

texture again. 

  

2 "Save Segment to the Project" button transferring the satisfactory result of the conversion to the STL list. 

 

 

 

 

 

 

DATA STRUCTURES 

 

Data structures encompass both STL objects and textures organized into lists. There are two lists: one for STL 

surfaces and another for textures. 

 

1. STL 

The STL list includes all project STL objects and the object named “Box”. STL object can be converted to texture 

by dragging the surface from STL list to Texture list (see Annex H.Hotkeys). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1 Color indicator 

2 

Buttons for toggling the 

visualization, locking, and 

deleting of the STL surfaces 

3 

The "Box" STL surface visualizes 

the Region of Interest facets 

and designed as square visible 

in MPR 
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2. Segment list 

 

Segment window includes a list of textures and additional buttons. The list of textures displays all the defined 

segments that can be edited. Additional textures can be added using the corresponding buttons or by dragging 

from the list of STL files (See Annex H.Hotkeys). Segments can also be constrained within the STL object (See 

Annex H.Hotkeys). 

To activate a necessary texture, click on its name in the list. The control buttons in the texture list function 

similarly to the buttons in the STL list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Additional buttons 

 

Add  

Add tool is used to include additional textures. Left-clicking on the "Add" button initiates the insertion of a new 

region of interest. Move, resize, or rotate the purple box to define the boundaries of the future texture. Click the 

"Add" button again when the new area is defined. 

 

 

Note! 
The texture selection will be limited to the original area of interest, regardless of the 

resulting box's size. 

 

Invert 

Invert tool is used to reverse the voxels of an active texture.  

 

 

Note! The "invert" works when the texture is unlocked. 

 

Sum up 

Sum up tool) is used to sum up or subtract textures. Left-click the “Sum up” button, select the rows of textures 

involved in the process, and press  "+"  or  "-". The resulting texture will be shown in the texture list as a new line 

 

 

  

1 Segments list 

2 Add button 

3 Invert button 

4 Sum up button 
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AUXILIARY CONTROLS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1 

Show Contour checkbox toggles the visualization 

modes for the selected zone in 2D slices. It allows 

you to choose between two options: displaying 

the entire array with a color indication or 

representing the array as a contour. The color 

indication is shown in the texture table and can 

be modified if needed. 

2 
Opacity allows for the adjustment of the 

transparency level of the selected area. 

3 

Scroll  adjusts scrolling discreteness for panorama 

mode and rotated slices, controlling the level of 

granularity when navigating through layers and 

rotated slices. Isn't applicable in MPR mode. 

4 

Speed allows to adjust the rate at which the 

optical density level changes. This feature is active 

in the 3D Brush and 2D Brush modes, specifically 

in the "Smart" mode. It is also active when 

adjusting the optical density level of a grown 

zone in "Growing" mode. 

5 

"Min" and "Max" controllers are intended for 

general or local change of the minimum and 

maximum optical density threshold. Checkboxes 

of these controllers determine which of the 

thresholds will be changed when working with 3D 

Brush, 2D Brush Smart mode, and when adjusting 

the optical density level of the grown zone in the 

Growing mode. 
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HOTKEYS 

 

Shortcuts Functions 

When the cursor is in the slice window 

Pressing of the needed figure (1-9) 

1 - leaving one largest object. 

2 - keeping the two largest objects 

3 - the largest three objects are left. 

4-9 - leaving the largest objects in the texture volume. 

Shift + Scroll 
Changing the optical density level of a single slice (with the 

unlocked texture) 

“Enter” button 

Selection of the closed texture areas in the current slice 
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When the cursor is in the rendering window 

Pressing of the needed figure (1-9) 

1 - leaving one largest object. 

2 - keeping the two largest objects 

3 - the largest three objects are left. 

4-9 - leaving the largest objects in the texture volume. 

Shift + Scroll 
Changing the optical density level of a single slice (with the 

unlocked texture) 

“Enter” button 

 
Selecting the closed parts of the texture in the texture volume. 

Modifying operations 

Backspace Cancellation the operation 

Shift + Left mouse button Rotation of the slice window 

Shift + Right mouse button Scaling the slice window 

Ctrl + 
Operation of the 2D Brush in "Smart" mode: smoothly and 

gradually changes the texture within the specified cursor zone. 
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Alt + function 

Optimizing work in MPR mode with local editing tools. After 

scrolling and locally editing the desired texture layers, pressing Alt 

+ N (where N is a number from 1 to 9) saves the N largest texture 

parts, including unedited slices of the series, and highlights closed 

sections. 

Dragging the necessary STL line to the empty 

part of the texture table 
Conversion the STL to the texture 

Dragging the needed STL line to the necessary 

texture line 

Restricting texture selection to an STL contour. 

Required condition - the closed contour of the STL, or closed 

contour of any STL with the ROI box 

Slice numbering 

The number of MPR slices on each axis depends on the size of the 

ROI box and the selected Grid Size dispersion. 

 

Buttons to lock the result 

"Convert" button 

Converting the edited texture to an STL surface u If there are 

multiple volumes in the texture list, the active texture will be 

converted. 

If the texture needs additional editing after conversion, the 

program applies additional editing and converts the texture again. 

"Save Segment to the Project" 

button 
Transferring the satisfactory result of the conversion to the STL list. 

"Finish" button 
Exiting from the Segmentation editor. The unsaved segment will 

be lost. 
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Stackable Surgical guide 
 

 

CHAPTER I STACKABLE SURGICAL GUIDE COMPONENTS 

 

 

FIXATION BASE 

The Fixation Base’s initial function is bone reduction. The upper edge of 

the Fixation Base is created to indicate the level to which the bone needs 

to be reduced. The second function of the Fixation Base is to support the 

components: Osteotomy Guide, Carrier Guide, PMMA, Ceramic or 

(Provisional) Prosthetic.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PIN GUIDE 

Pin Guide’s only purpose is to deliver the Fixation Base and maintain its 

position while the fixation pins are set. 

Dentate Pin Guides seat on the teeth are verified via revision windows and 

ensure the surgery starts in the correct position. With edentulous patients, 

the Pin Guide will seat exactly like the denture and verify the bite and 

ultimate tooth position. 
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OSTEOTOMY GUIDE 

Osteotomy Guide controls the implant depth, trajectory, and indexing 

(rotation) during osteotomy creation. It seats into the Fixation Base and is 

fixed using Locks.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 CARRIER GUIDE (OPTION) 

 

One function of the Carrier Guide is to serve as a tissue gap between the 

top of the bone reduction to the bottom of the Prosthetic. The Carrier 

Guide remains in the mouth through the prosthetic conversion. The two 

or three clear plastic pegs on the Carrier Guide deliver the prosthetic in 

the proper position as planned.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

PROVISIONAL PROSTHETIC, PRINTED TRY-IN 

 

The Provisional is a strong and esthetic prototype for the final restoration. 

It is designed for immediate load and extended use. The Provisional is 

delivered the day of surgery and remains in use until the final prosthetic 

delivery. 
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СHAPTER II 

 
SOFTWARE FUNCTIONAL 

You can create surgical stackable guides with INNO PLAN if the beta version of the software is uploaded and 

activated on your computer.  

This chapter describes how to create a stackable surgical guide using the step-by-step workflow. 

 

Preparation Step 

 

Click "Surgical Guides" (1) in the Tab Panel menu to open 

the tab.  

 

In this window, click "Make Stackable Surgical Guide" (2) to 

open the surgical guide settings menu. 
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Step 1 

Initiating Surgical Guide Design 

Define the borders of the surgical guide by clicking the scanning surface along the desired margin line.  

 

Then double-click to close a surgical guide margin line.  

 

Now you can move points on a margin line by dragging 

and moving them with your mouse. 

  

 

 

 

 

 

 

 

 

 

 

Using the surgical guide settings menu, you can define 

settings for the surgical guide and its representation in the 

3D-rendering view. 

 

Select a surgical guide insertion direction - 

Mandible/Maxilla (1). 

 

Use the Guide Offset (mm), Thickness (mm), Side angle 

(deg) settings to define the design properties of the 

surgical guide (2, 3, 4). 

 

Select "High palate" if the palate is unusually high and 

narrow (5). 

 

Select "Smooth Surface" for smoothing the top of the 

guide surface (6). 

 

In Step windows, clicking "Next Step" saves the settings for 

this work step and takes you to the next step (7). 

 

Clicking "Cancel" closes the window but discards all 

settings specified since you have started the step (8). 
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Step 2 

Plane Settings 

 

Using the Fixation base, Bone reduction Guide, Pin 

guide and Carrier guide settings menu for the surgical 

guide: 

 

Select a Bone reduction guide surface design – “Planes” 

or “Curve” (see Top Figure -1a,b and Down Figure 1a); 

Use the “Guide Height” settings to define the height of 

the Fixation Base (see Down Figure -3 and Top Figure - 

2); 

Show/hide the Fixation Base plane by clicking the 

checkbox (see Top Figure 3);  

Use the “Guide Height” settings to define the height of 

the Carrier guide (see Down Figure - 4 and Top Figure - 

4); 

Show/hide the Carrier Guide plane by clicking the 

checkbox (see Top Figure - 5); 

You can also reset the default values for the Fixation 

base height (5 mm) and Carrier guide height (3 mm) 

(see Top Figure - 6); 

Use the sliders "STL" and "Guide" transparency to define 

the STL and Guide surface opacity (see Top Figure - 7a, 

7b); 

Show/hide the Cross Slice plane by clicking the 

checkbox (see Top Figure - 7c); 

Show/hide the Guide Slice plane by clicking the 

checkbox (see Top Figure - 7d); 

In the Step window, clicking "Back" returns you to the 

previous step (see Top Figure - 8); 

In Step windows, clicking "Next Step" saves the settings 

for this work step and takes you to the next step; 

Clicking "Cancel" closes the window but discards all 

settings specified since you have started the step  

(see Top Figure - 9). 

  



. 

137 

 

Step 3 

Osteotomy guide, Carrier guide and Prosthetic design settings 

 
Using the Osteotomy guide / Carrier guide / 

Prosthetic settings menu for the surgical guide: 

If you want to use the bone reduction option 

select the "Bone reduction" checkbox (see Top 

Figure - 1); 

Select the surface you will use for the osteotomy 

guide from the list of the STL (see Top Figure - 2); 

Use the “Thickness (mm)” settings to define the 

thickness of the Osteotomy guide (see Top Figure 

- 3); 

Use the “Offset from bone (mm)” settings to 

define the offset from bone for the Osteotomy 

guide (see Top Figure  4); 

Select the desired Osteotomy guide type using 

the two checkboxes "solid" (see Top Figure 5 and 

Down Figure - 1) and "on bars" (on lock-

supported pontics (see Top Figure - 5 and Down 

Figure - 2). 

 

Select the desired Prosthetic type using the 

corresponding checkboxes (see Top Figure - 6); 

 

Select the surface you will use for the prosthetic 

from the list of the STL (see Top Figure - 7); 

Select the checkbox and the prosthetic will be cut 

off automatically and will be based on the 

position and shape of the surface you selected in 

the Bone Reduction settings, when finalizing the 

surgical guide design (see Top Figure - 8); 

In Step windows, clicking "Next 

Step" saves the settings for this 

work step and takes you to the 

next step;  

Clicking "Cancel" closes the 

window but discards all settings 

specified since you have started 

the step. 
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Step 4 

Implant-supported and Pin-supported area settings 

 

Using the Implant-supported and Pin-supported 

area settings menu: 

 

Use the “Sleeve support diameter (mm)” settings to 

define the diameter of the implant sleeve support 

(1); 

 
Use the “Handpiece contact area diameter (mm)” 

settings to define the diameter of the contact area 

(2); 

 
Use the “Sleeve safety zone height (mm)” settings to 

define the sleeve safety zone height of the implant 

sleeve support (3); 

 
Use the “Offset from sleeve (mm)” settings to define 

the offset between the sleeve and the inner surface 

of the implant sleeve support (4); 

 
In this step, you define the pin position. (5) Select 

and refine the pin position by moving and/or 

rotating the pin (see INNO PLAN Instruction for 

Use); 

 
Use the “Sleeve support diameter (mm)” settings to 

define the diameter of the pin sleeve support (6); 

 
Use the “Handpiece contact area diameter (mm)” 

settings to define the diameter of the contact area 

(7); 

 
Use the “Sleeve safety zone height (mm)” settings to 

define the sleeve safety zone height of the pin sleeve support (8); 

 
Use the “Offset from sleeve (mm)” settings to define the offset between the sleeve and the inner surface of the 

pin sleeve support (s9); 

 
Select (10), place (1) and refine the lock position by moving the lock (2); 
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Using the "Locks" menu you can load the different types of locks. 

Click “Load From Server”, select checkbox and click OK. Use “Add to library” button to add a custom STL file of 

the lock from your PC.  

Enter the section name, model name and you can choose the color of the STL file.  

Then import STL files of the base surface, shank surface and hole (the subtraction body) from a selected source 

using the "Import STL" buttons. 

Lock library downloading 

 

 

 

Move the cursor to the desired position on the fixation base with your mouse and left-click to set the lock (1); 

Once you have set a lock position, you can still change its position by dragging it with your mouse. To delete a 

lock, click the right mouse button on the lock and then delete (2). 

  

Refining the lock position. 
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Step 5 

Osteotomy Guide on the lock-supported bars design settings 

 

This step is only available if you have selected the option "On Bars" in the Osteotomy Guide Settings step (Step 

3). 

Use the “Diameter (mm)” settings to define the diameter of the lock-supported pontic.  
Show/hide the visualization of the numerical value of the pontic diameter by clicking the checkbox ( 1a, 1b); 
Once you have set all pontics for the osteotomy guide you can click “Proceed” and proceed with the workflow 

(2);  
Click “Clear” to abort the support pontic placement step (3); 
Click a position at the sleeve support area and when you move your mouse away from this point, a purple solid 

bar is displayed between the pink point and the mouse cursor position. Click a position at the desired surface to 

set the bar at this selected area (4, 5). Now you can change the shape and diameter of the bar by dragging 

points and scrolling the mouse will. 
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Step 6 

Temporary cylinder area settings menu 

 

You can select to set up the diameter (1) and 

bottom (2) of the holes for the Multi-Unit 

Prosthetic Temporary Cylinders, around the 

abutment axis. To skip this step, click the 

"Don't cut Abutment Axis Cylinders" button 

(3, 3a, 3b). 
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Step 7 

Carrier guide design settings 

 
This step is only available if you have selected the option "Based on Carrier Guide" in the Carrier Guide Settings 

step (Step 3). 

The transparent plastic pegs on the Carrier Guide deliver the Provisional Prosthetic in the proper position as 

planned.  

Move the cursor to the desired position on the carrier guide with your mouse and left-click to set the peg (a); 

Once you have set a peg, you can still change its position by dragging it with your mouse. To delete a peg, click 

the right mouse button on the peg and then delete (b).  

Use the “Peg Height (mm)” settings to define the height of the peg (1); 

 
Use the “Peg Diameter (mm)” settings to define the diameter of the peg basis (2); 

 
Use the “Offset from Peg (mm)” settings to define the offset between the peg and the inner surface of the 

Provisional Prosthetic (3); 

 
Once you have set all pegs for 

the carrier guide you can click 

“Proceed” and proceed in the 

workflow (4);  

 
Click “Clear” to abort the peg 

placement step workflow (5); 

 
Clicking "Cancel" closes the 

window but discards all 

settings specified since you 

have started the step (6). 
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Step 7 

Provisional Prosthetic on the lock-supported pontics settings 

 

This step is only available if you have selected the option "On Lock-Supported Pontics" in the Prosthetic Settings 

step (Step 3). Use the same techniques as described in Step 5. 
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Step 8 

Support Bar settings 

You can add a support bar to the surgical stackable guide’s surface. Use the same techniques as described in 

Step 5. 

Select "Place Support Bar" in the menu (1);  
Click a position to the desired position on the stackable guide and when you move your mouse away from this 

point, a purple solid bar is displayed between the pink point and the mouse cursor position. Click a position at 

the desired surface to set the bar at this selected area. Now you can change the shape and diameter (2) of the 

bar by dragging points and scrolling the mouse will; 
To delete a Support Bar, right-click on it and delete. 
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Step 8 

Label text settings 

You can add a text label to the surgical stackable guide’s surface. 

Figure 2.8.1.1 Label text settings. 

Select "Place Label" in the menu (1); 
Type the desired text into the text field (2); 
Using the window below the text field, you can change the depth (3);  
Move the text to the desired position on the stackable guide surface and click to set it, then proceed (4). 
To delete a text, right-click on it and delete. 
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Step 8 

Revision window settings 

You can also add a revision window(s) to the surgical stackable guide’s surface.  

Select "Place Viewing Window" in the menu (1); 
Move the window shape (2) to the desired position on the stackable guide surface and click to set it. 
To delete a revision window, right-click on it and delete. 
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Step 9 

Finalizing the Project 

Planning result files (STL files and PDF files) are created in the planning result files generation and finalizing step. 

You can check the result of your planning in the views and finalize the project by clicking the "move to the 

project" button or clicking "Back" if you are in doubt or not satisfied with the result. 

  

Note! Your account will be charged the 3 exports. 
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BETA VERSION DISCLAIMER 

 

The INNO PLAN Stackable Guide software and all content found on it are provided on an “as is” and “as 

available” basis. 

 

Cowellmedi Inc. will not be liable for any loss, whether such loss is direct, indirect, special or consequential, 

suffered by any party as a result of their use of the INNO PLAN Stackable Guide software.  

 

Any downloading, uploading or editing of material on the INNO PLAN Stackable Guide software is done at the 

user’s own risk and the user will be solely responsible for any damage to any persons or loss of data that results 

from such activities. 
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